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Note: When you use the instrument, follow generally accepted procedures for quality 
control and methods development.

If you observe a change in the retention of a particular compound, in the resolution 
between two compounds, or in peak shape, immediately determine the reason for the 
changes. Until you determine the cause of a change, do not rely on the separation results.

Note: The Installation Category (Overvoltage Category) for this instrument is Level II. The 
Level II Category pertains to equipment that receives its electrical power from a local level, 
such as an electrical wall outlet.

STOP
Atención: Changes or modifications to this unit not expressly approved by the party 
responsible for compliance could void the user’s authority to operate the equipment.

Important : Toute modification sur cette unité n’ayant pas été expressément approuvée 
par l’autorité responsable de la conformité à la réglementation peut annuler le droit de 
l’utilisateur à exploiter l’équipement.

Achtung: Jedwede Änderungen oder Modifikationen an dem Gerät ohne die 
ausdrückliche Genehmigung der für die ordnungsgemäße Funktionstüchtigkeit 
verantwortlichen Personen kann zum Entzug der Bedienungsbefugnis des Systems 
führen.

Avvertenza: eventuali modifiche o alterazioni apportate a questa unità e non 
espressamente approvate da un ente responsabile per la conformità annulleranno 
l’autorità dell’utente ad operare l’apparecchiatura.

Atención: cualquier cambio o modificación efectuado en esta unidad que no haya sido 
expresamente aprobado por la parte responsable del cumplimiento puede anular la 
autorización del usuario para utilizar el equipo.



Caution: Use caution when working with any polymer tubing under pressure:

• Always wear eye protection when near pressurized polymer tubing.

• Extinguish all nearby flames.

• Do not use Tefzel tubing that has been severely stressed or kinked.

• Do not use Tefzel tubing with tetrahydrofuran (THF) or concentrated nitric or 
sulfuric acids.

• Be aware that methylene chloride and dimethyl sulfoxide cause Tefzel tubing to 
swell, which greatly reduces the rupture pressure of the tubing.

Attention : Soyez très prudent en travaillant avec des tuyaux de polymères sous 
pression :

• Portez toujours des lunettes de protection quand vous vous trouvez à proximité de 
tuyaux de polymères.

• Eteignez toutes les flammes se trouvant à proximité.

• N'utilisez pas de tuyau de Tefzel fortement abîmé ou déformé.

• N'utilisez pas de tuyau de Tefzel avec de l'acide sulfurique ou nitrique, ou du 
tétrahydrofurane (THF).

• Sachez que le chlorure de méthylène et le sulfoxyde de diméthyle peuvent 
provoquer le gonflement des tuyaux de Tefzel, diminuant ainsi fortement leur 
pression de rupture.

Vorsicht: Bei der Arbeit mit Polymerschläuchen unter Druck ist besondere Vorsicht 
angebracht:

• In der Nähe von unter Druck stehenden Polymerschläuchen stets Schutzbrille 
tragen.

• Alle offenen Flammen in der Nähe löschen.

• Keine Tefzel-Schläuche verwenden, die stark geknickt oder überbeansprucht sind.

• Tefzel-Schläuche nicht für Tetrahydrofuran (THF) oder konzentrierte Salpeter- 
oder Schwefelsäure verwenden.

• Durch Methylenchlorid und Dimethylsulfoxid können Tefzel-Schläuche quellen; 
dadurch wird der Berstdruck des Schlauches erheblich reduziert.



Precauzione: prestare attenzione durante le operazioni con i tubi di polimero sotto 
pressione:

• Indossare sempre occhiali da lavoro protettivi nei pressi di tubi di polimero 
pressurizzati.

• Estinguere ogni fonte di ignizione circostante.

• Non utilizzare tubi Tefzel soggetti a sollecitazioni eccessive o incurvati.

• Non utilizzare tubi Tefzel contenenti tetraidrofurano (THF) o acido solforico o 
nitrico concentrato.

• Tenere presente che il cloruro di metilene e il dimetilsolfossido provocano 
rigonfiamento nei tubi Tefzel, che riducono notevolmente il limite di pressione di 
rottura dei tubi stessi.

Advertencia: manipular con precaución los tubos de polímero bajo presión:

• Protegerse siempre los ojos en las proximidades de tubos de polímero bajo 
presión.

• Apagar todas las llamas que estén a proximidad.

• No utilizar tubos Tefzel que hayan sufrido tensiones extremas o hayan sido 
doblados.

• No utilizar tubos Tefzel con tetrahidrofurano (THF) o ácidos nítrico o sulfúrico 
concentrados.

• No olvidar que el cloruro de metileno y el óxido de azufre dimetilo dilatan los tubos 
Tefzel, lo que reduce en gran medida la presión de ruptura de los tubos.





Caution: The user shall be made aware that if the equipment is used in a manner not 
specified by the manufacturer, the protection provided by the equipment may be 
impaired.

Attention : L’utilisateur doit être informé que si le matériel est utilisé d’une façon non 
spécifiée par le fabricant, la protection assurée par le matériel risque d’être 
défectueuses.

Vorsicht: Der Benutzer wird darauf aufmerksam gemacht, dass bei unsachgemäßer 
Verwenddung des Gerätes unter Umständen nicht ordnungsgemäß funktionieren.

Precauzione: l’utente deve essere al corrente del fatto che, se l’apparecchiatura viene 
usta in un modo specificato dal produttore, la protezione fornita dall’apparecchiatura 
potrà essere invalidata.

Advertencia: el usuario deberá saber que si el equipo se utiliza de forma distinta a la 
especificada por el fabricante, las medidas de protección del equipo podrían ser 
insuficientes.



Caution: To protect against fire hazard, replace fuses with those of the same type and 
rating.

Attention : Remplacez toujours les fusibles par d’autres du même type et de la même 
puissance afin d’éviter tout risque d’incendie.

Vorsicht: Zum Schutz gegen Feuergefahr die Sicherungen nur mit Sicherungen des 
gleichen Typs und Nennwertes ersetzen.

Precauzione: per una buona protezione contro i rischi di incendio, sostituire i fusibili con 
altri dello stesso tipo e amperaggio.

Advertencia: sustituya los fusibles por otros del mismo tipo y características para evitar 
el riesgo de incendio.



Caution: To avoid possible electrical shock, disconnect the power cord before servicing 
the instrument.

Attention : Afin d’éviter toute possibilité de commotion électrique, débranchez le cordon 
d’alimentation de la prise avant d’effectuer la maintenance de l’instrument.

Vorsicht: Zur Vermeidung von Stromschlägen sollte das Gerät vor der Wartung vom 
Netz getrennt werden.

Precauzione: per evitare il rischio di scossa elettrica, scollegare il cavo di alimentazione 
prima di svolgere la manutenzione dello strumento.

Precaución: para evitar descargas eléctricas, desenchufe el cable de alimentación del 
instrumento antes de realizar cualquier reparación.



Commonly Used Symbols

Direct current
Courant continu
Gleichstrom
Corrente continua
Corriente continua

Alternating current
Courant alternatif
Wechselstrom
Corrente alternata
Corriente alterna

Protective conductor terminal
Borne du conducteur de protection
Schutzleiteranschluss
Terminale di conduttore con protezione
Borne del conductor de tierra



Frame or chassis terminal
Borne du cadre ou du châssis
Rahmen- oder Chassisanschluss
Terminale di struttura o telaio
Borne de la estructura o del chasis

 

Caution or refer to manual
Attention ou reportez-vous au guide
Vorsicht, oder lesen Sie das Handbuch
Prestare attenzione o fare riferimento alla guida
Actúe con precaución o consulte la guía

Caution, hot surface or high temperature
Attention, surface chaude ou température élevée
Vorsicht, heiße Oberfläche oder hohe Temperatur
Precauzione, superficie calda o elevata temperatura
Precaución, superficie caliente o temperatura elevada

Commonly Used Symbols (Continued)



Caution, risk of electric shock (high voltage)
Attention, risque de commotion électrique (haute tension)
Vorsicht, Elektroschockgefahr (Hochspannung)
Precauzione, rischio di scossa elettrica (alta tensione)
Precaución, peligro de descarga eléctrica (alta tensión)

Caution, risk of needle-stick puncture
Attention, risques de perforation de la taille d’une aiguille
Vorsicht, Gefahr einer Spritzenpunktierung
Precauzione, rischio di puntura con ago
Precaución, riesgo de punción con aguja

Caution, ultraviolet light
Attention, rayonnement ultrviolet
Vorsicht, Ultraviolettes Licht
Precauzione, luce ultravioletta
Precaución, emisiones de luz ultravioleta

Commonly Used Symbols (Continued)

UV



Fuse
Fusible
Sicherung
Fusibile
Fusible

Electrical power on
Sous tension
Netzschalter ein
Alimentazione elettrica attivata
Alimentación eléctrica conectada

Electrical power off
Hors tension
Netzschalter aus
Alimentazione elettrica disattivata
Alimentación eléctrica desconectada

Commonly Used Symbols (Continued)
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Waters Micromass ZQ Detector Information

Intended Use

Waters designed the Waters® Micromass® ZQ™ Detector to with an HPLC system to 
determine mass-to-charge ratio (m/z) for a wide range of analytes.

Biological Hazard

When you analyze physiological fluids, take all necessary precautions and treat all 
specimens as potentially infectious. Precautions are outlined in “CDC Guidelines on 
Specimen Handling,” CDC – NIH Manual, 1984.

Calibration

Follow the calibration methods set forth in this guide, using pure standards. The 
concentration range should cover the entire range of quality-control samples, typical and 
atypical specimens.

Quality Control

Routinely run three quality-control samples. Quality-control samples should represent 
subnormal, normal, and above-normal levels of a compound. Ensure that quality-control 
sample results are within an acceptable range, and evaluate precision from day to day and 
run to run. Data collected when quality-control samples are out of range may not be valid.
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Preface

The Waters Micromass ZQ Detector Operator’s Guide describes procedures for 
unpacking, installing, using, maintaining, and troubleshooting the Waters® Micromass® 
ZQ™ Detector. Its appendixes explain how to use the optional ESCi™ Multi-Mode 
Ionization Source, and list instrument specifications, accessories, and spare parts.

This guide is intended for individuals who need to install, operate, maintain, and/or 
troubleshoot the Micromass ZQ Detector.

Organization

This guide contains the following:

Chapter 1 describes the instrument, including its features and options.

Chapter 2 describes how to unpack and install the instrument and how to make power, 
liquid line, gas, signal, and other hardware connections.

Chapter 3 describes how to configure the instrument, start it operating, and tune and 
calibrate it.

Chapter 4 describes how to set up a calibration file and specify calibration parameters 
in MassLynx™.

Chapter 5 explains routine maintenance procedures.

Chapter 6 describes troubleshooting procedures.

Appendix A explains how to use the ESCi Multi-Mode Ionization Source option.

Appendix B presents instrument specifications.

Appendix C lists recommended and optional accessories and spare parts.

Related Documentation

Waters Licenses, Warranties, and Support: Provides software license and warranty 
information, describes training and extended support, and tells how Waters handles 
shipments, damages, claims, and returns.

Online Documentation
23

MassLynx Help: Describes all MassLynx windows, menus, menu selections, and 
dialog boxes for the base software and software options. Also includes reference 
information and procedures for performing all tasks required to use MassLynx software. 
Included as part of the MassLynx software.



Printed Documentation for Base Product

MassLynx User’s Guide

MassLynx Interfacing Guide

MassLynx Security User’s Guide

MassLynx 4.0 Guide to Inlet Control

MassLynx 4.0 Guide to ZQ Data Acquisition

Waters Micromass ZQ with MassLynx v4.0 Software and Instrument Verification 
Procedure

Related Adobe Acrobat Reader Documentation

For detailed information about using Adobe® Acrobat® Reader, see the Adobe Acrobat 
Reader Online Guide. This guide covers procedures such as viewing, navigating, and 
printing electronic documentation from Adobe Acrobat Reader.

Printing This Electronic Document

Adobe Acrobat Reader lets you easily print pages, page ranges, or the entire document by 
selecting File > Print. For optimum print quantity, Waters recommends that you specify a 
PostScript® printer driver for your printer. Ideally, use a printer that supports 600 dpi print 
resolution.

Documentation Conventions

The following conventions can be used in this guide:

Convention Usage

Purple Purple text indicates user action such as keys to press, menu selec-
tions, and commands. For example, “Click Next to go to the next 
page.”

Italic Italic indicates information that you supply such as variables. It also 
indicates emphasis and document titles. For example, “Replace 
file_name with the actual name of your file.”

Courier Courier indicates examples of source code and system output. For 
example, “The SVRMGR> prompt appears.”

Courier Bold Courier bold indicates characters that you type or keys you press in 
examples of source code. For example, “At the LSNRCTL> prompt, 
enter set password oracle to access Oracle.”
24



Notes

Notes call out information that is helpful to the operator. For example:

Note: Record your result before you proceed to the next step.

Attentions

Attentions provide information about preventing damage to the system or equipment. For 
example:

Underlined Blue Indicates hypertext cross-references to a specific chapter, section, 
subsection, or sidehead. Clicking this topic using the hand symbol 
brings you to this topic within the document. Right-clicking and 
selecting Go Back from the shortcut menu returns you to the origi-
nating topic. For example, “Monitoring Readbacks are described in 
Section 3.4, Readbacks”

Keys The word key refers to a computer key on the keypad or keyboard. 
Screen keys refer to the keys on the instrument located immediately 
below the screen. For example, “The A/B screen key on the 2414 
Detector displays the selected channel.”

… Three periods indicate that more of the same type of item can 
optionally follow. For example, “You can store filename1, filename2, 
… in each folder.”

> A right arrow between menu options indicates you should choose 
each option in sequence. For example, “Select File > Exit” means 
you should select File from the menu bar, then select Exit from the 
File menu.

STOP
Attention: To avoid damaging the detector flow cell, do not touch the flow cell 
window.

Convention Usage
25



Cautions

Cautions provide information essential to the safety of the operator. For example:

Caution: To avoid burns, turn off the lamp at least 30 minutes before removing it for 
replacement or adjustment.

Caution: To avoid electrical shock and injury, unplug the power cord before 
performing maintenance procedures.

Caution: To avoid chemical or electrical hazards, observe safe laboratory practices 
when operating the system.
26
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Chapter 1
Overview

This chapter describes the Waters® Micromass® ZQ™ Detector, its features and options.

1.1  About the Micromass ZQ Detector

The ZQ Detector is a quadrupole mass analyser that can determine the mass-to-charge 
ratio (m/z) of diverse analytes. An HPLC system, or syringe pump, delivers liquid sample 
to the instrument’s analyser source. There the sample molecules ionize by means of one 
of two ionization modes: electrospray (ESI) or atmospheric pressure chemical ionization 
(APCI). In ESI mode, sample molecules ionize in solution before they reach the source. 
On entering the evacuated source, they begin a desolvation process. In APCI mode, an 
electrical discharge inside the source ionizes the sample molecules whereupon they 
undergo desolvation.

The ions ultimately reach the quadrupole, which separates them according to their 
mass-to-charge ratios. A photomultiplier then detects the mass-separated ions, amplifies 
their signals, and sends the mass information to the data system.

Probes

An electrospray ionization (ESI) probe or an atmospheric pressure chemical ionization 
(APCI) probe introduces the sample to the ion source.

Sample Inlet

Either of two methods deliver solvent and sample to the installed probe:

• An HPLC system – Delivers the eluent from an HPLC analysis.

• A built-in syringe pump – Delivers standard solutions or infusions of unknown 
samples.

Vacuum System

An external rotary (roughing) pump and an internal split flow turbomolecular pump 
combine to create the source vacuum. The turbomolecular pump evacuates the analyser 
and ion transfer region.

Vacuum leaks and electrical or vacuum pump failures cause vacuum loss, which 
protective interlocks guard against. The system monitors turbomolecular pump speed and 
About the Micromass ZQ Detector 27
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continuously measures vacuum pressure with a built-in Pirani gauge. The gauge also 
serves as a switch, discontinuing detector operation when it senses vacuum loss.

A vacuum isolation valve isolates the source from the mass analyser, allowing routine 
source maintenance without venting.

Mass Analyser (Quadrupole)

The mass analyser separates ions by mass-to-charge ratio (m/z).

Data System

The data system collects information from the mass analyser and includes these 
components:

• MassLynx™ 4.0 software

• An external workstation

• An embedded PC

MassLynx software controls the workstation-based data system and mass detector 
through the detector’s embedded PC. Using MassLynx, you tune the instrument, set up 
and run the HPLC system, and acquire and process data. When they are part of the 
system, the software also controls the autosampler and the divert and injector valves.

The workstation uses a Windows NT®, Windows® 2000, or Windows XP color graphical 
environment and allows full user interaction with the keyboard or mouse. A network link 
communicates between the workstation and the detector’s embedded PC.

MassLynx acquires and stores data from conventional LC detectors simultaneously with 
data the mass detector acquires. It can also acquire data from selected systems, like 
Waters 996/2996 Photodiode Array Detectors. Consult the MassLynx 4.0 Guide to Inlet 
Control for details about MassLynx.

1.2  Theory and Principles of Operation

Electrospray Ionization (ESI)

In ESI, a high electrical voltage charges the eluent as it emerges from a nebulizer, 
producing an aerosol of charged droplets. As the solvent evaporates, the droplets shrink, 
developing a charge dense enough to eject ions from their surfaces (ion evaporation). The 
mass analyser then sorts the singly or multiply charged ions by mass-to-charge m/z ratio.

The analyser source can accommodate eluent flows of up to 1 mL/min. You can enhance 
performance by reducing the rate of eluent flow at the ion source.
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Atmospheric Pressure Chemical Ionization (APCI)

A heated nebulizer vaporizes the sample. The sample ions then merge with solvent ions in 
the atmospheric source, enabling proton transfers between the solvent and sample ions.

APCI generally produces both protonated and deprotonated molecular ions from the 
sample. For positive ions, this ionization occurs by means of a proton transfer mechanism. 
For negative ions, the mechanism is proton abstraction.

1.3  MassLynx 4.0 Software

MassLynx 4.0 software permits these major operations:

• Configuring the instrument

• Creating HPLC inlet and MS methods that define operating parameters for a run

• Tuning and calibrating the mass detector

• Running samples

• Monitoring the run

• Acquiring data

• Processing data

• Reviewing data

• Printing data

See the MassLynx 4.0 Guide to Inlet Control and MassLynx Help for more information on 
installing and using MassLynx software.
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Chapter 2
Installing

This chapter describes how to unpack and install your Waters Micromass ZQ Detector. 
Figure 2-1 summarizes these procedures.

Installation 
Begins

Installation 
Complete

Select and Prepare 
Appropriate Site

Unpack and Inspect Install 
ESI Probe

Connect Rheodyne 
Injector Tubing

Install Rotary Pump

Set Up
Syringe Pump

Install Oil Return 
Connection Kit

Connect 
Workstation

Connect N2 and 
Exhaust
30

Figure 2-1  Installing the Detector



2

2.1  Site Selection and Power Requirements

Install the detector on a stable, level, and appropriately clean surface that meets the 
specifications in Table 2-1.

Table 2-1  Installation Site Requirements

Factor Requirement

Temperature range 15 to 28 °C (59 to 82.4 °F)

Relative humidity 
range

20 to 80%, noncondensing

Bench space Width: 15.2 in. (38.1 cm)
Depth: 26 in. (66.1 cm)
Height: 23 in. (57.2 cm)
Weight: 210 lb. (95.3 kg)

Clearance Rear: 4.75 in. (120 mm)
Right side: 20 in. (0.5 m) to allow for service access. 

Note: Movable equipment can be located as close as 4.75 in. 
(120 mm).

Left side: 0.0 in./mm
Top: 11 in. (28 cm)

Power requirements Grounded AC, 230 V, 50/60 Hz

Electromagnetic fields No nearby source of electromagnetic noise, such as NMR 
systems or magnetic sector mass spectrometers

Static electricity Negligible

Vibration Negligible

STOP
Attention: To avoid overheating the instrument, allow the prescribed clearances at the 
top, sides, and rear of the instrument.

STOP
Attention: To avoid damaging the instrument, measure the voltage at the 230 VAC outlet 
before installing the instrument. Readings of less than 208 VAC indicate the need for a 
step-up transformer.
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2.2  Unpacking and Inspecting

The Waters Micromass ZQ system is shipped in several cartons. Among them, they 
contain these items:

• Micromass ZQ Detector with Startup Kit

• Rotary pump

• MassLynx workstation

• MassLynx 4.0 documentation set

• Waters Micromass ZQ Detector Operator’s Guide

Required Material

Utility knife or scissors

Procedure

1. Note any tipping or shock indicators on the cartons that shipping might have 
triggered. Also, inspect the carton for damage.

2. Cut and remove the straps that secure the large carton.

3. Lift the carton off the pallet.

4. Remove foam packing material from the top of the instrument.

5. Remove the Startup Kit, and set it aside.

6. Lift the detector from the foam support on the pallet and carefully set the unit down 
on a bench.

Note: The instrument should overhang the bench top by several inches to allow the 
waste tube, which extends from the lower-right corner, a straight descent to the 
liquid waste container.

7. Check the Startup Kit contents against the accompanying parts list to confirm that 
all items are included.

8. Open the carton containing the rotary pump, then remove the packing material and 
Startup Kit.

9. Carefully remove the rotary pump, and set it temporarily down on a level surface.

Caution: At least four people must lift the instrument from its shipping pallet 
and place it on the bench.
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Contacting Waters Technical Service

Inspect all items for damage. Immediately report any shipping damage to both the carrier 
and Waters. North American customers who report damage should contact Waters 
Technical Service at 800 252-4752. All others should call their local Waters subsidiary or 
Waters corporate headquarters in Milford, Massachusetts (U.S.A.).

2.3  Installing the Detector

This section describes how to install the Waters Micromass ZQ 2000 and ZQ 4000 
Detectors.

2.3.1  Installing the Rotary Pump

1. Place the rotary pump on the floor, within 5 feet of the instrument. Place the PTFE 
drip tray beneath the pump.

2. Fill the pump with oil:

a. Remove the filler plug.

b. Pour oil into the pump until the level reaches the MAX mark on the bezel at the 
oil-level sight glass. If the level exceeds the MAX mark, remove the drain plug, 
and let the excess oil drain (Figure 2-2).

c. After a few minutes, recheck the oil. If the level is now below the MAX mark, add 
the appropriate amount of oil.

d. Refit the oil filler plug. Finger tighten it. Do not overtighten it.

STOP
Attention: The rotary pump is shipped without oil. You must fill it with oil before 
starting it.

Oil Filler Plug

MAX
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Note: Use Ultragrade 19 or Inland Q45 oil only. Refer to the manufacturer’s manual 
for more information about filling the pump with oil.

3. Attach the NW25 tee, included in the Startup Kit, to the inlet of the rotary pump 
using the NW25 center ring and clamp (Figure 5-1).

4. Attach a length of 1-inch ID vacuum hose to each open port on the NW25 tee. Use 
the NW25 flanges, center rings, and clamps provided in the Startup Kit.

5. Connect the opposite ends of the two lengths of vacuum hose to the two straight 
NW25 vacuum ports on the detector’s rear panel. Use NW25 flanges, center rings, 
clamps, and elbows, as necessary.

6. Remove the nozzle fitting on the pump exhaust port, and replace it with the NW25 
flange and O-ring from the Startup Kit.

Note: Ensure the NW25 flange is tight. Pump vibration can loosen it, causing oil to 
leak.

7. Connect the oil mist filter assembly to the pump exhaust port. Use an NW25 center 
ring and clamp.

8. Connect an NW25 nozzle fitting to the oil mist filter assembly. Use an NW25 center 
ring and clamp.

9. Connect the 12-mm clear PVC exhaust tubing to the NW25 nozzle fitting. Secure 
the tubing with a hose clamp.

10. Route the open end of the exhaust tubing to a suitable exhaust vent.

11. Remove the drain plug and bonded seal from the oil mist filter housing. Save the 
drain plug for future use.

12. Connect the female end of the rotary pump power cord to the connector on the 
rotary pump relay box. Connect the male end of the power cord to the rotary pump 
connector on the instrument’s rear panel.

13. Turn the power switch to On.

Note: The pump will not start at this time. It is controlled by the system software.

2.3.2  Installing the Oil Return Connection Kit

The oil return connection kit collects excess oil from the oil mist filter housing and returns it 
to the rotary pump oil reservoir.

1. Install the drain adaptor and bonded seal onto the oil mist filter drain port 
(Figure 2-3).
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Figure 2-3  Fitting the Gas Ballast and Hose adaptors to the Rotary Pump

2. Remove the circlip, wire mesh, and filters from the gas ballast inlet on the pump.

3. Insert the gas ballast adaptor and O-ring into the gas ballast inlet port on the pump.

4. Connect the hose adaptor to the gas ballast adaptor. Use the banjo bolt and the two 
bonded seals.

5. Estimate how much flexible oil return tubing you need to loosely connect the oil mist 
filter housing’s drain port to the pump’s inlet port. When fitted, the tube must be free 
of kinks or tight bends.

6. Cut the tubing, ensuring the cut ends are burr-free and square.

7. Lubricate the restrictor with oil, then insert it into one end of the tube.

8. Connect one end to the drain adaptor on the oil mist filter housing, and the other end 
to the hose adaptor.

9. Secure the ends of the tube with hose clips.

2.3.3  Connecting the Nitrogen Supply and Exhaust
1. Connect one end of a length of the 6-mm PTFE tubing to the N2 In port on the rear 

1.   E1/E2M Pump
2.   Filters
3.   Wire Mesh
4.   Circlip
5.   O-Ring
6.   Gas Ballast Adaptor
7.   Bonded Seal
8.   Hose Adaptor
9.   Bonded Seal
10. Banjo Bolt
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Figure 2-4  ZQ Detector Rear Panel

2. Attach a nitrogen regulator to the nitrogen supply, and install the 6-mm stud 
(Figure 2-5) into the regulator outlet.

Figure 2-5  Nitrogen Stud

3. Connect the free end of the 6-mm PTFE tubing to the 6-mm stud.

4. Locate the drying gas exhaust bottle (Figure 2-6) in an accessible area.

5. Cut a length of 10-mm tubing long enough to connect the instrument to the drying 
gas exhaust bottle. Connect one end of the tubing to the exhaust port on the rear 
panel. Connect the other end to one of two ports on the drying gas exhaust bottle.

6. Cut a second length of 10-mm tubing long enough to connect the drying gas 
exhaust bottle to the exhaust vent. Insert one end of the tubing into the remaining 
port on the drying gas exhaust bottle. Route the other end to the exhaust vent.

Vacuum Ports

Rotary Pump
Power Connection

N2 Exhaust

N2 In Port
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Figure 2-6  Drying Gas Exhaust Bottle

7. Route the PTFE waste tubing from the detector’s lower-right corner to a suitable 
liquid waste container.

2.3.4  Connecting the Rheodyne Injector (for Manual Injections)

Refer to Figure 2-7 for this procedure.

1. Connect the PTFE waste tube to injector port 5.

2. Install the needle port fitting onto injector port 6.

3. Connect the 10-µL injection loop between injector ports 1 and 4.

4. Connect the LC system tubing to injector port 2.

STOP
Attention: The instrument requires two separate exhaust systems, one for 
nitrogen, the other for the rotary pump. Vent them to atmosphere through 
separate exhaust lines. Oil mist can seriously damage the instrument when 
the nitrogen exhaust line connects with the rotary pump exhaust line. Your 
warranty does not cover damage caused by routing exhaust lines incorrectly.
Installing 37



2

Figure 2-7  Rheodyne Injector

2.3.5  Installing the ESI Probe

Refer to Figure 2-8 for this procedure.

1. Connect the PTFE tubing from the probe adjustment flange to the desolvation gas 
port on the front panel.

2. Remove the protective sleeve, if fitted, from the electrospray probe tip.

3. Slide the probe into the hole in the probe adjustor plate until the probe body rests on 
the probe adjustment flange. The probe identification contacts must touch the 
screws on the probe adjustment flange.

4. Secure the probe with the two knurled thumbscrews.

5. Connect the 4-mm PTFE tubing from the probe to the nebulizer gas port. 

6. Connect the electrical lead from the probe to the capillary connector on the front 
panel.

5

6

1

2

3

4

(To Source)
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Figure 2-8  ESI Probe in Situ

2.3.6  Connecting the Workstation

Waters ships the workstation with preinstalled MassLynx software. Before connecting the 
workstation to the instrument, set it up according to its accompanying instructions. You 
should locate the workstation within 16 feet (5 meters) of the instrument.

1. Connect one end of the network cable to the appropriate port on the rear panel of 
the detector.

2. Connect the other end of the network cable to the port labeled ZQ on the 
workstation rear panel.

Caution: Do not connect the instrument’s power supply cord until you complete the 
installation procedures in the previous sections.

Probe Cable

Desolvation Gas Port

Source Cable

Nebulizer Gas Port

Knurled Thumbscrews (2)

Probe

Source Cover

Source Cover Clip

Flange

Probe Adjustor Plate

Probe Adjustor

Source Cover Clip
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To connect the instrument to the power source:

1. Select the correct power cord for your location.

2. Connect the female end of the power cord to the power port on the rear panel of the 
instrument.

2.3.7  Preparing the Syringe and Syringe Pump

This section refers to the 250-µL Hamilton syringe, various syringe fittings, and the API 
Setup Solution (polypropylene glycol/reserpine/cyclodextrin) found in the Startup Kit.

1. Flush the syringe three times with methanol or a volume-to-volume mixture of 70% 
methanol : 30% water. 

2. Load the syringe with the setup solution, and connect the Rheodyne 9013 needle 
port fitting to the PEEK union, finger tightening it.

3. Clip the ground cable (with the plug-in clip), located on the lower-right side of the 
front panel, into the syringe needle.

4. Fit the syringe into the syringe pump, and set the syringe stop accordingly 
(Figure 2-9).

Caution: To avoid electrical shock, always ground the needle.

Caution: The syringe pump includes a positive syringe stop to prevent 
certain syringe types from breaking. Nevertheless, as added protection 
against syringe breakage, you should set the syringe stop adjustor. This 
prevents the syringe plunger from traveling its full stroke inside the syringe 
barrel, reducing the potential for breakage.

Syringe

Needle Port
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Chapter 3
Tuning

Tuning involves adjusting source settings, analyser settings, and gas flows to produce 
optimal peak intensities.

After you tune, calibrate the instrument in electrospray (ESI) mode, even if you intend to 
operate it in APCI mode. See Section 3.3.3 for details about tuning in APCI mode.

3.1  Opening MassLynx and Starting the Instrument

1. Double-click the MassLynx V4.0 desktop icon to open the application. The 
MassLynx Login dialog box appears (Figure 3-1).

Figure 3-1  MassLynx Login Dialog Box

2. Complete the Logon Name, Password, and Domain fields.

Note: The Login dialog box appears only when you enable MassLynx security. Otherwise, 
the MassLynx Main window (Figure 3-2) appears after you click the MassLynx V4.0 
desktop icon. See the MassLynx Security User’s Guide (version 4.0) for details about 
enabling MassLynx security.
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3. Click OK. The MassLynx Main window appears (Figure 3-2).

Figure 3-2  MassLynx Main Window

Note: After initiating, the Main window displays “Instrument Present” in the status 
bar.

4. The shortcut bar should appear in the MassLynx Main window, and “Instrument” 
should appear at its top. If it fails to appear, click Shortcut, in the toolbar, to open it. 
Then click Instrument, at the left edge of the shortcut bar. 

5. Select MS Tune from the Main window (Figure 3-2) shortcut bar to open the Tune 
window (Figure 3-3).

Status Bar

Shortcut Bar

Toolbar

Information Bar

Menu Bar
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Figure 3-3  Tune Window Displaying the ES+ Source Page

3.2  Tuning in ESI Mode

Table 3-1 describes the Tune window’s ES+ Source page parameters.

Note: The voltage parameters shown in this table optimize sensitivity and stability. The 
temperature and flow rate parameters control the extent of solvent evaporation and adduct 
formation.

Table 3-1  ES+ Source Page Parameters

Parameter Description

Capillary voltage Enhances or suppresses ion density by supplying excess charge 
to droplets. Optimal voltages: 2 to 4 kV for positive ions and 2 to 
3 kV for negative ions.
Tuning in ESI Mode 43

Cone voltage Helps draw ions into the first vacuum region (20 to 70 V optimal).

Extractor voltage Focuses ions toward the hexapole RF lens (3 to 10 V optimal). 
Increasing voltage can induce fragmentation.

RF Lens voltage Focuses ions toward the center of the quadrupole (~0.5 V).
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Source and Desolvation Temperatures

The Source and Desolvation temperature settings control desolvation for a specified flow 
rate. Table 3-2 gives temperature ranges for specific flow rates. 

3.2.1  Specifying Parameter Settings on the ES+ Source Page
1. Click  (API Gas) in the Tune window to toggle the nitrogen flow to On. 

2. Make sure the instrument is operating, noting whether peak activity appears in the 
Tune window’s Peak Display area (Figure 3-3). If the instrument is not operating 
(indicated by no peaks), click Press for Operate.

Source temperature See Table 3-2.

Desolvation 
temperature

See Table 3-2.

Desolvation gas flow Optimizes gas flow depends on mobile phase composition and 
flow rate (>100 L/hr).

Cone gas flow Helps reduce adduct ions and keep the sample cone clean (50 
to150 L/hr).

Table 3-2  Source and Desolvation Temperature Settings

HPLC Flow 
Rate (µL/hr)

Source Temperature oC Desolvation Temperature oC

<100 80 to 100 100 to 350

100 to 250 100 to 130 350 to 400

250 to 1000 130 to 150 400 to 450

STOP
Attention: You must toggle API gas to Off before reopening the nitrogen 
supply once it has been shut off. Otherwise, the sudden inrush of gas can 
damage the flow meter.

Table 3-1  ES+ Source Page Parameters (Continued)

Parameter Description
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3. Click the ES+ Source tab, and specify these suggested starting parameters in the 
corresponding fields of the ES+ Source page. 

4. Select all four Peak Editor fields, and enter these mass assignment values.

5. Select Options > Syringe Type. The Syringe Selection dialog box appears 
(Figure 3-4).

Parameter Suggested Value

Capillary (kV) 3.5

Cone (V) 60

Extractor (V) 3

RF Lens (V) 0.5

Source Temp (oC) 80

Desolvation Gas Flow (L/hr) 300

Desolvation Temp (oC) 150

Cone Gas Flow (L/hr) 50

STOP
Attention: Monitor readbacks, letting the source temperature, desolvation 
gas flow, desolvation temperature, and cone gas flow reach their setpoints 
before proceeding. See Section 3.4 for details about monitoring readbacks.

Mass Span Gain

175.1 5 10

609.3 5 10

1080.8 5 10

2034.6 5 10
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6. Ensure the drop-down list displays Hamilton 250uL, then click OK.

7. Set the syringe pump to deliver 10 µL/min by entering that rate in the Pump Flow 
field of the Analyser page (Figure 3-5).

8. Click  (Syringe pump) to infuse the startup solution into the source.

9. Click the Analyser tab, and ensure the syringe pump flow rate is 10 µL/min.

10. Turn the probe adjustor (see Figure 2-8) in one direction or the other to optimize 
peak intensities.

11. Adjust the capillary, cone, extractor, and RF lens voltages to optimize peak 
intensities.

3.2.2  Specifying Parameter Settings on the Analyser Page

Analyser settings optimize mass peak resolution. With span settings at 5, the bases of 
mass peaks as they appear on the Tune window Analyser page should measure 1 da.

Note: The parameters LM Resolution, HM Resolution, and Ion Energy optimize resolution.

Table 3-3 describes the Tune window’s Analyser page parameters.

1. Click the Analyser tab. The Tune window Analyser page appears (Figure 3-5).

Table 3-3  Analyser Page Parameters

Parameter Description

LM Resolution
HM Resolution

Affect mass peak concentration. Usually, 15, an arbitrary 
unit, yields adequate mass resolution. Increasing the value 
lowers sensitivity; decreasing it enhances sensitivity.

Ion Energy (V) Decreases resolution. Set between –1 and 3 V, as low as 
possible without reducing peak intensity.

Multiplier (V) Modifies gain (attenuation). Settings between 400 and 450 
yield a suitable signal-to-noise balance.
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Figure 3-5  Tune Window Displaying the Analyser Page

2. Specify these suggested starting parameters in the Analyser page fields. 

Note: If you change HM and/or LM Resolution after calibrating the instrument, you should 
recalibrate. Otherwise, any data the instrument acquires could fall outside the calibration 
mass range.

3.3  Tuning in APCI Mode

Parameter Suggested Value

LM Resolution 15

HM Resolution 15

Ion Energy 0.3

Multiplier 650
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After you tune and calibrate (see Chapter 4 for calibration information) in ESI mode, you 
may tune for APCI operation. This entails preparing the source, installing a tee fitting 
upstream of the probe, and specifying APCI parameters.
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3.3.1  Preparing the Source for APCI Operation

To prepare the source for APCI tuning when the instrument is in ESI mode:

1. Prepare the syringe according to the procedure in Section 2.3.7, loading it with API 
Setup Solution from the Startup Kit.

2. Click Press for Standby on the lower right of the Tune window.

3. Disconnect the nebulizer gas line and both electrical connections from the front 
panel.

4. Remove the ESI probe.

5. Insert the APCI probe into the source, tightening the two thumbscrews.

6. Connect the APCI nebulizer and desolvation gas lines at the front panel.

7. Open the source enclosure cover.

8. Remove the blanking plug from the corona pin mounting contact, and fit the corona 
discharge pin (Figure 5-9). Align the tip of the corona discharge pin with the tip of 
the sample cone.

9. Close the source enclosure cover.

10. Connect the electrical lead to the Source/Probe receptacle on the front panel.

11. Click Press for Operate.

The source is now ready for APCI operation.

Caution: The ion source block is hot. It can reach 150 °C, maintaining its set 
temperature, even with the source enclosure removed.

STOP
Attention: Do not start the liquid flow until the gas flow and probe heater are switched on 
and the probe inserted.
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3.3.2  Installing the Tee Fitting

To optimize APCI peaks, temporarily install a tee fitting to merge the sample flow from the 
syringe pump with the solvent flow from an HPLC pump. The combined sample/solvent 
stream flows into the probe (Figure 3-6).

Figure 3-6  Combined Flow into the Tee

1. Connect the HPLC pump tubing to injector port 2 (see Figure 2-7 for port positions).

2. Connect the capillary from the syringe pump to one of the tee’s three ports.

3. Connect a 1/16-in. OD × 0.007 in. ID × 1 M tube between injector port 3 and a 
second tee port.

4. Connect another 1/16-in. OD × 0.007 in. ID × 1 M tube from APCI probe to the tee’s 
third port.

3.3.3  Specifying Parameters on the APCI+ Source Page

Table 3-4 describes the APCI+ Source page parameters.

Table 3-4  APCI+ Source Page Parameters

Parameter Description

Corona Affects sensitivity. The amount of current required depends on 
the polarity of both the compound and mobile phase.
Optimize when mobile phase is present.

APcI Probe Temp Affects sensitivity. Start at 650 oC and reduce in 50o steps, 
allowing time for stabilization to take place before reading.
Optimize while mobile phase is flowing.

HPLC Pump Flow
From Injector Port 3

Combined Flow 
into Probe

Syringe Pump 
Flow
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Desolvation Gas flow rate usually affects signal intensity only marginally. 
Nevertheless, adjusting it can suppress chemical background 
noise.

Cone Gas Gas flow rate can minimize formation of solvent adducts.
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1. Select Ion Mode > APCI+ from the Tune window (Figure 3-3). The APCI+ Source 
page appears (Figure 3-7).

Figure 3-7  Tune Window Displaying the APCI+ Source Page

2. Click  (API Gas) in the Tune window to toggle the nitrogen flow to On.

Note: If you do not observe any peak activity, the instrument may not be in 
operational mode. To remedy this, click Press for Operate.

STOP
Attention: You must toggle API gas to Off before reopening the nitrogen 
supply once it has been shut off. Otherwise, the sudden inrush of gas can 
damage the flow meter.
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3. Specify these suggested parameters in the APCI+ Source page fields. 

4. Select all four Peak Editor fields, and enter these mass assignment values.

5. Start the LC pump, specifying a 1 mL/min flow rate.

6. Click  (Syringe pump) to infuse the startup solution into the source.

7. Click the Analyser tab, and ensure the syringe pump flow rate is 10 µL/min.

Turn the probe adjustor (see Figure 2-8) in either direction to optimize peak 
intensities.

Parameter Suggested Value

Corona (µA) 0.1

Cone (V) 48

Extractor (V) 3

RF Lens (V) 0.0

Source Temp (oC) 120

Desolvation Gas Flow (L/hr) 300

APcI Probe Temp (oC) 500

Cone Gas Flow (L/hr) 50 

STOP
Attention: Before proceeding, let the source temperature, desolvation gas 
flow, desolvation temperature, and cone gas flow reach their setpoints. See 
Section 3.4 for information about monitoring readbacks.

Mass Span Gain

175.1 5 10

609.3 5 10

1080.8 5 10

2034.6 5 10
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3.4  Readbacks

Readbacks report current instrument performance in most of the parameters whose 
values you specify on the Tune window’s pages. They appear as red numerals in read-only 
fields. These fields are adjacent to those that contain the parameters’ set values. Monitor 
readbacks to determine whether the instrument performs to your parameter settings.

MassLynx provides readbacks on all Tune window pages. You can, however, prevent them 
from appearing on the Source and Analyser pages or limit their display to those that are 
out of range.

1. Select Options > Readbacks to open the Readbacks dialog box (Figure 3-8).

Figure 3-8  Readbacks Dialog Box

2. Evaluate readbacks, including those on the Diagnostics page (Figure 3-9). Most 
Source and Analyser page readbacks should match the parameter values you 
specify.

Note: Some readbacks serve a broad diagnostic purpose and therefore do not 
necessarily mirror their set values. For example, a voltage readback can vary from 
its set value when the instrument’s proper operation does not depend on that 
voltage. In such a case, whether voltage is at all present is the more critical 
measure.
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Figure 3-9  Diagnostics Page Readbacks

3. Let the ion beam stabilize for 3 to 5 minutes.

4. Monitor for mass peaks, which should appear at approximately the mass values you 
specified on the ES+ Source or APCI+ Source page.
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Chapter 4
Calibrating

Calibrating the mass scale entails setting up a calibration file and specifying calibration 
parameters in MassLynx.

4.1  Setting Up the Calibration File

Before calibrating, you must remove the current calibration file and select a reference file:

1. Select Calibration > Calibrate Instrument from the Tune window (Figure 3-3). The 
Calibration window appears (Figure 4-1).

Figure 4-1  Calibration Window

2. Select NaICs2 from the reference file list to choose the reference file, if your ZQ 

Reference File
List
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Mass Detector is a 2000 model. Select NaICs4 if it is a 4000 model.
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3. Select File > Open. The Open dialog box appears (Figure 4-2).

Figure 4-2  Open Dialog Box

4. Select Uncal.cal, and click Open. The Calibration window reappears.

5. Make sure the phrase “No calibration” follows the three calibration types: Static, 
Scanning, and Scan Speed Compensation.

4.2  Setting Calibration Parameters

The rest of this chapter describes how to specify calibration parameters in these windows 
and dialog boxes:

• Tune window

• Instrument Threshold Settings dialog box

• Automatic Calibration Check dialog box

• Calibration Parameters dialog box

• Mass Measure dialog box

• Automatic Calibration dialog box

• Calibration Acquisition Setup dialog box

4.2.1  Tune Window Settings
1. Follow the syringe preparation procedure in Section 2.3.7, this time loading the 
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syringe with sodium cesium iodide solution (from the API Test Kit).

2. Click  (Syringe pump) in the Tune window to infuse the solution into the source.
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3. Enter these suggested initial reference solution values in Tune window’s Peak 
Editor.

Note: These settings are offered as reference points only and, once adopted, might 
require adjusting.

4. Select rows 1 to 4 in the Peak Editor. This specifies four mass peaks in the Tune 
window’s Peak Display area (see Figure 3-3).

5. Click the ES+ Source tab, and enter these suggested parameters in the 
corresponding fields of the ES+ Source page (Figure 4-3).

Row Mass (ZQ 2000) Mass (ZQ 4000) Span Gain

1 172.9 172.9 5 8

2 772.5 1521.9 5 20

3 1521.9 2271.4 5 40

4 1971.6 3470.5 5 39

Parameter Suggested Value

Capillary (kV) 3.5

Cone (V) 50

Extractor (V) 3

RF Lens (V) 0.5

Source Temperature (oC) 80

Desolvation Gas Flow Rate (L/hr) 250

Desolvation Temperature (oC) 120

Cone Gas Flow (L/hr) 50

Caution: Failure to flow desolvation gas during ESI operation can damage 
the source.
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Figure 4-3  Tune Window Displaying the ES+ Source Page

6. Click the Analyser tab to open the Analyser page (Figure 4-4), and enter these 
suggested parameters in the corresponding fields.

Parameter Suggested Value

LM resolution 15

HM resolution 15

Ion energy (V) 0.5

Multiplier (V) 600

Cone Gas Flow Rate (L/hr) 50

Syringe Pump Flow Rate (µL/min) 5
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Figure 4-4  Tune Window Displaying Analyser Page Parameters

7. Maximize the signal intensity of the four mass peaks in the Tune window Peak 
Display:

a. Turn the probe adjustor knob (Figure 2-8) to adjust the orientation of the probe 
relative to the sample cone orifice.

b. Adjust the source parameters from the Tune window’s ES+ Source page. These 
include Capillary, Extractor, RF Lens, and Cone voltages, as well as desolvation 
and cone gas flows.

8. Adjust the slide adjustors for LM (low mass) Resolution, HM (high mass) Resolution, 
and Ion Energy on the Tune window’s Analyser page (Figure 3-5) to obtain a 
full-width-at-half-height measurement of 0.4 to 0.6 da.

Note: Make sure you can see all ions and that none are saturated on a gain of 1X.

4.2.2  Instrument Threshold Settings Dialog Box
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This dialog box contains parameters that control how the system preprocesses data 
before sending the data to a host computer.
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For most low mass-range calibrations, the instrument acquires calibration data in 
continuum mode. The continuum-data parameter settings in the Instrument Threshold 
Settings dialog box ensure appropriate scanning speeds.

1. Select Options > Set Instrument Threshold from the Tune window. The 
Instrument Threshold Settings dialog box appears (Figure 4-5). 

2. Accept the default settings by clicking OK.
 

Figure 4-5  Instrument Threshold Settings Dialog Box

4.2.3  Automatic Calibration Check Dialog Box

Select Edit > AutoCal Check Parameters from the Calibration window (Figure 4-1). The 
Automatic Calibration Check dialog box appears (Figure 4-6).

Figure 4-6  Automatic Calibration Check Dialog Box
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Missed Reference Peaks – Specifies the maximum number of unmatched consecutive 
peaks you allow between the reference spectrum and the acquired calibration spectrum. 
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The calibration fails when the number of unmatched peaks exceeds the maximum you 
specify. The default value, 2, in most cases suffices.

Maximum Std Deviation – For each pair of matched peaks, MassLynx calculates the 
difference between the measured mass in the acquired calibration file and the true mass 
in the reference file. The calibration fails when the standard deviation for a set of mass 
differences exceeds the maximum standard deviation you specify. Decreasing the value 
imposes a more stringent limit. Increasing it makes the requirement easier to meet, though 
you should normally avoid setting values greater than 0.20, the default value.

Apply Span Correction – Enabling this option ensures correct mass assignment, even 
when the mass scale differs from the one the instrument was calibrated with.

Note: You should not enable this option when the mass range of interest is less than 1000 
da and includes the subrange 0 to 150 da.

Check Acquisition Calibration Ranges – Waters recommends you enable this option, 
which displays messages alerting you when the instrument attempts to acquire data 
outside the calibrated ranges for mass and scan speed.

4.2.4  Calibration Parameters Dialog Box

Select Edit > Calibration Parameters from the Calibration window (Figure 4-1) to open 
the Calibration Parameters dialog box (Figure 4-7).
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Figure 4-7  Calibration Parameters Dialog Box
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Parameters

Perform auto peak matching – When enabled, matches peaks in the reference file to 
those in the acquired file.

Peak window – Specifies the maximum mass difference between the reference peaks 
and the expected position of corresponding peaks in the acquired spectrum. Normal 
operating range is 0.3 to 1.5 da.

Initial error – Specifies the maximum mass difference you will allow between the first 
reference peak the software chooses (for its position at or near the center of the calibration 
range) and the peak it corresponds to in the acquired spectrum.

Note: Increasing Peak window and Initial Error values may result in incorrect peak 
matching.

Intensity threshold – Specifies the lower intensity limit of peaks that form the calibration 
curve. The threshold is expressed as a percentage of the most intense peak of the 
acquired spectrum. Normal operating range is 0 to 5%.

Note: MassLynx does not use any peaks in the acquired spectrum that fall below the 
Intensity threshold parameter.

Polynomial order – Once MassLynx matches each peak in the reference spectrum to one 
in the acquired spectrum, it calculates the mass difference (the acquired mass less the 
reference mass) for each peak pair. It then plots these differences as points on a graph 
and fits a smooth curve through the points. This parameter, set to values 0 to 5, 
determines the type of curve MassLynx draws:

• Polynomial order = 0 – a horizontal baseline

• Polynomial order = 1 – a linear curve

• Polynomial order = 2 – a quadratic curve

• Polynomial order = 3 – a cubic curve

• Polynomial order = 4 – a fourth-order curve

• Polynomial order = 5 – a fifth-order curve

Waters suggests a polynomial order of 2 for calibrations that use sodium cesium iodide as 
the reference solution and where the calibrated mass range starts below 100 da and 
extends through 650 da. Use polynomial order 4 for the wide mass ranges at the high end 
of the mass scale (600 to 1000+ da) and for calibrating with widely spaced reference 
peaks.

Intensity weighting – Weights the curve toward points that represent the more intense 
acquired peaks. Thus each point’s weight equals the square root of the acquired peak’s 
intensity.
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Calibrate display – Lets you calibrate the raw data peaks in the upper graph of the 
Calibration report. As you select each peak, the display recalibrates, bringing the other 
spectral masses into line.

4.2.5  Mass Measure Dialog Box

Mass measure parameters control conversion of raw continuum data to centroid data, 
which the calibration process requires. You must therefore specify them before calibrating 
in ESI mode.

Note: If you use centroid data for calibration, you need not specify mass measure 
parameters.

Select Edit > Calibrate Quad Mass Measure Parameters from the Calibration window 
(Figure 4-1). The Mass Measure dialog box appears (Figure 4-8).

 

Figure 4-8  Mass Measure Dialog Box
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4.2.6  Automatic Calibration Dialog Box

You should perform all three types of calibration: static, scanning, and scan speed 
compensation. This lets you subsequently use any data acquisition mode. It also lets you 
change mass ranges and scan speeds while maintaining correct mass assignment.

1. Select Calibration > Calibrate Instrument from the Tune window. The Calibration 
window appears (Figure 4-1).

2. Select Calibrate > Start Acquisition from the Calibration window. The Automatic 
Calibration dialog box appears (Figure 4-9).

Figure 4-9  Automatic Calibration Dialog Box

3. Specify the type or types of calibration you intend to perform: Static, Scanning, 
and/or Scan Speed.

Note: For a complete calibration, select Static Calibration, Scanning Calibration, 
and Scan Speed Compensation in the Types area. Then, in the Process area, 
select Acquire & Calibrate and Print Report.

Considerations
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Though Waters suggests you perform all three types of calibration, you can nevertheless 
specify one, or any combination, of calibration types. Beware, however, that doing so 
invokes the following limitations:

• Specify Static to calibrate only for acquisitions where the quadrupole “parks” at a 
single mass (for example, SIR acquisitions).
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• Specify Scanning to calibrate only for scanning acquisitions. This limits acquisitions 
to the same mass range and scan speed you specified in the calibration.

• Specify Scan Speed Compensation to calibrate only for scanning acquisitions over 
the same mass range and at the same scan speed you specified in the calibration. 
Thus to correctly calibrate for scan speed compensation, you must also perform a 
scanning calibration.

• Specify both Static and Scan Speed Compensation to calibrate for acquisitions 
where the quadrupole “parks” at a single mass. Also, provided you specify the same 
scan speed, this calibrates for scanning acquisitions whose mass ranges lie within 
the scanning calibration’s mass ranges. Accordingly, when you specify a 2-second 
scan (400 amu/sec) calibration from 100 to 900 m/z, the instrument can acquire data 
from 100 to 500 amu for a 1-second scan (also 400 amu/sec) and maintain correct 
mass assignment. In this case the static calibration would determine the acquisition’s 
start mass and the scanning calibration the mass assignment and scan range.

• Specify both Scanning Calibration and Scan Speed Compensation to calibrate for 
scanning acquisitions over the mass range you specify for the calibration. You can, 
however, change the scan speed, provided it remains within the scan speeds you 
specified in the two calibrations. In this case do not change the mass range, because 
no static calibration exists to locate the start mass.

• Specify all three types of calibration, Static, Scanning, and Scan Speed 
Compensation, to allow all types of acquisitions, provided the mass range and scan 
speed fall between the lower and upper limits for scanning calibration and scan speed 
compensation.

4.2.7  Calibration Acquisition Dialog Box

Specify mass ranges, scan speeds and acquisition mode in this dialog box, which, when 
you first open it, contains default parameter values for the specified reference file. These 
values represent the scan range and speed limits of the parameters and instrument.

Note: For improved calibration performance, Waters suggests you adopt the parameter 
values in Table 4-1.

Click Acquisition Parameters in the Automatic Calibration dialog box (Figure 4-9) to open 
the Calibration Acquisition Setup dialog box (Figure 4-10).
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Figure 4-10  Calibration Acquisition Setup Dialog Box 

Table 4-1  Recommended Calibration Acquisitions Setup Parameters

Parameter ZQ 2000 ZQ 4000

Scan From (amu) 50 50

Scan To (amu) 2040 4080

Run Duration (mins) 1.0 2.0

Data Type Continuum Continuum

Static Span ± (amu) 4 4

Static Dwell (sec) 0.1 0.1

Slow Scan Time (sec) 10 20

Fast Scan Time (sec) 0.40 0.90

Inter Scan Delay (sec) 0.1 0.1
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Parameters

Scan From, Scan To – Specifies the scan range for each calibration type.

Run Duration – Specifies how much time the instrument takes to acquire each calibration 
data file.

Data Type – Specifies data type as centroid, continuum, or MCA. Waters suggests using 
continuum or MCA acquisitions for electrospray calibrations.

Note: Calibrating in MCA mode limits maximum acquisition speed to 400 da/sec.

Static Span – Specifies how much of the mass scale on either side of a reference peak 
the instrument scans.

Static Dwell – Specifies the time the instrument takes to scan the static span.

Slow Scan Time – Specifies how much time it takes the instrument to scan the mass 
scale over the selected range when acquiring data for scanning calibrations (see next 
section for details).

Fast Scan Time – Specifies how much time it takes the instrument to scan the mass 
scale over the selected range when acquiring data for scan speed calibrations (see 
next section for details).

Inter Scan Delay – Specifies how much time elapses between the end of one scan and 
the beginning of another.

Main – Resets all parameters to their default values.

About Establishing Scan Speeds

Table 4-1 shows Waters’ recommended parameter settings for using sodium cesium 
iodide as the calibrant. However, if you do not calibrate with sodium cesium iodide, you 
might need to derive your own scan speed parameter values.

To determine Slow Scan Speed and Fast Scan Speed parameter values, first decide what 
scan speed range to acquire your sample data within. Do this by applying the following 
equation twice, once to establish the range’s lower limit and once to establish its upper 
limit:

Scan speed = Scanning range / Scan time + Interscan delay

Note: These calculations use the ZQ 2000 parameter values in Table 4-1.

Use Slow Scan Time to calculate the slowest scan speed a calibration can accommodate 
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(the range’s lower limit). Thus, where Slow Scan Time = 10 seconds:

Scan speed = (2040 - 50)/(10 + 0.1) = 197 amu/sec
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Use Fast Scan Time to calculate the fastest scan speed the calibration can accommodate 
(the range’s upper limit). Thus, where Fast Scan Time = 0.4 seconds:

Scan speed = 2040 – 50/0.4+0.1 = 3980 amu/sec

The scan speed range for this calibration is 197 to 3980 amu/sec.

Checking the Calibration

Select Process > Verification From File from the Calibration window (Figure 4-1) to view 
a successful or failed calibration. The Display Calibration Graphs dialog box appears 
(Figure 4-11). From it you can select a calibration type for viewing. With the required 
calibration selected, MassLynx automatically displays the correct calibration file.

Figure 4-11  Display Calibration Graphs Dialog Box

Note: Data for the selected calibration type must appear in the lower frame of the dialog 
box. If it does not, click Browse to find the correct file.

Click OK to repeat the calibration and display a Calibration report.

Calibration Report
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MassLynx momentarily displays a successful calibration and then prints its Calibration 
report. However, if the standard deviation of a calibration’s residuals exceeds the preset 
maximum, the software displays a set of calibration graphs in the Calibration window 
(Figure 4-12). These help you identify the problem.
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The top calibration graph shows the calibration file. The peak-matching algorithm, which 
matches calibration peaks to reference peaks, shows the peaks in a contrasting color.

The Data and Reference file graphs show the calibration spectrum with its highlighted 
peaks matched with reference peaks of a contrasting color. Other graphs show mass 
difference and residuals.

Updating the Calibration Report

1. Select Edit > Calibration Parameters from the Calibration window. The Calibration 
Parameters dialog box appears (Figure 4-7).

2. Enter changes, and click OK.

Printing the Calibration Report

1. Click the Calibration window (Figure 4-1) to activate it.

2. Click Yes to save changes in the calibration file. The Save As dialog box appears.

3. Enter a file name in the File name field.

Note: Waters recommends you incorporate the current date in every file you name.

4. Click Save or Cancel. The Automatic Calibration dialog box appears (Figure 4-9).

5. Select Scan Speed Compensation as the calibration type.

6. Select Acquire & Calibrate and Acquire & Verify as the process methods.

7. Select Print Report, and click OK. The Calibrate window appears displaying 
calibration graphs (Figure 4-12).

8. Check the Mean Residual Error parameter, which must be equal to or less than ± 
0.2 for a calibration to be successful.
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Figure 4-12  Calibrate Window Showing ZQ-4000 Calibration Graphs

Calibration Failure

Calibration failures result from many causes. If too many mass peaks are missed, check 
data in the on-screen Calibration report. If the missed masses appear there, one or more 
of the first three causes listed in Table 4-2 likely apply. If the data include these mass 
peaks, but they nevertheless go unrecognized during calibration, one or more of the 
subsequently listed causes probably induced the failure.

Table 4-2  Calibration Failure Troubleshooting

Symptom Possible Cause Corrective Action

No peaks. No reference sample. Add reference sample.

No solvent flow into the 
source.

Check LC components, 
syringe pump, and liquid 
line connections.

Mean Residual
Error
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Multiplier set too low. Adjust multiplier.
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Having taken the necessary action, proceed as follows:

1. If the values in the Intensity threshold, Initial error, and Peak windows are adjusted 
to obtain a successful calibration, check the on-screen Calibration report to ensure 
the correct masses have been matched.

2. Click OK in the Calibrate window to accept the new calibration, or click Cancel to 
keep the previous calibration.

Incorrect Calibration

The instrument can sometimes meet the calibration criteria, despite failing to match the 
correct peaks. Such error can arise when you specify these settings:

• Intensity threshold set to 0

• Initial error greater than 2.0

• Peak window greater than 1.5

Too many consecutive 
peaks missed.

Reference solution in low 
supply or concentration.

Increase reference solu-
tion or its concentration.

Multiplier set too low to detect 
the less intense peaks.

Reset the Multiplier 
parameter.

Incorrect ionization mode 
selected.

Make sure the ionization 
mode matches the calibra-
tion file.

Intensity threshold too high. Lower threshold, or 
increase reference 
concentration.

Initial Error and/or Peak 
Window parameter set too low.

Increase parameter limits.

Maximum Std Deviation 
exceeded.

Widen (increase) the 
Maximum Std Deviation 
parameter.

The wrong reference file has 
been selected.

Select the appropriate 
reference file.

Table 4-2  Calibration Failure Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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• Maximum Std Deviation greater than 0.2

Always examine the on-screen Calibration report (Figure 4-12) for correct peak matches. 
The calibration is correct when the acquired spectrum looks like the reference spectrum, 
and it highlights all the expected peaks.
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Contamination or background peaks can also invalidate a calibration. For example, a 
contamination or background peak that lies within a peak-matching window might be more 
intense than its neighboring reference peak. Thus the software can choose the 
contamination or background peak instead of the reference peak. In such a case, if the 
reference peak is closer to the peak window’s center, narrow the peak window to exclude 
the contamination or background peak. If, on the other hand, the reference peak is not 
closer to the window’s center, and you cannot narrow the window without affecting it, edit 
the calibration manually.

Manually Editing Matched Peaks

You can manually exclude incorrectly matched peaks from the on-screen Calibration 
report. Manually editing a single peak will not affect other matched peaks in the 
calibration.

To exclude an incorrectly matched peak in an acquired spectrum, place the cursor over it 
and right-click. This removes the peak’s highlighting and excludes it from reported data.

To include a peak as a reference, place the cursor over it and right-click. This matches the 
selected peak to the closest peak in the reference spectrum.

Saving the Calibration

You can save and reuse calibrations.

Mass range and scan speed limits remain unchanged for retained calibrations. So do ion 
energy and resolution settings for calibration acquisition, which can affect mass 
assignment.

Verifying the Calibration

Once you perform and save a full instrument calibration, repeating it is not always 
necessary. Instead, you can make a scanning acquisition and verify a saved calibration, 
following this procedure:

1. Open the Calibration Parameters dialog box by selecting Edit > Calibration 
Parameters from the Calibration window (Figure 4-1).

2. Set all peak matching parameters to those used in the calibration.

3. Select Calibrate > Start Acquisition from the Calibration dialog box (Figure 4-1) to 
open the Automatic Calibration dialog box (Figure 4-9).

4. Enable these parameter fields in the Automatic Calibration dialog box:

• Scanning Calibration
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• Acquire & Verify

• Print Report

5. Disable these parameter fields:

• Static Calibration
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• Scan Speed Compensation

• Acquire & Calibrate

6. Click the Acquisition Parameters button to open the Calibration Acquisition Setup 
dialog box (Figure 4-10).

7. Set Scan From, Scan To, Run Duration, Data Type, Slow Scan Time, Fast Scan 
Time, and Inter Scan Delay to agree with the parameters you will use for data 
acquisition.

Note: No other options apply when you select Scanning Calibration.

8. Click OK. The Automatic Calibration dialog box reappears.

9. Click OK to start the verification procedure.

The instrument performs a scanning acquisition. Then MassLynx combines the data 
acquired into a single spectrum, which it compares with the reference file. MassLynx then 
creates and prints a calibration curve. Unlike the original calibration procedure, the 
instrument’s calibration remains unchanged, the printed report serving as verification.

Note: Do not adjust analyser settings (LM, HM resolution, and ion energy) after 
calibrating. Use only source parameters to optimize signal intensity.
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Chapter 5
Maintaining

This chapter includes routine maintenance procedures.

5.1  Considerations

Safety and Handling

Maintenance Equipment

Routine parts cleaning requires the following equipment:

• An ultrasonic bath with a minimum chamber size of 12 in. × 6 in. × 4 in. (300 mm × 
150 mm × 100 mm)

• Glass vessels, approximately 4 in. (100 mm) in diameter and 4 3/4 in. (120 mm) high

• A 500-mL graduated cylinder (to use when cleaning the hexapole assembly)

Caution: Observe good laboratory practice when you handle solvents, change tubing, or 
operate the instrument. Refer to Material Safety Data Sheets for the solvents you use, 
and know their chemical properties.

STOP
Attention: Do not touch integrated circuit chips or other circuit board components that do 
not specifically require manual adjustment. Static electric charge can damage electronic 
components.

STOP
Attention: Never open the instrument’s top or side panels to access power supplies or 
other components. The supplies do not contain user-serviceable parts.

STOP
Attention: Never disconnect an electrical assembly while the system is plugged in. This 
could damage electrical parts.
Attention: Also, turn off the power and wait 10 seconds before disconnecting an 
assembly.
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Contacting Waters Technical Service

North American customers who experience maintenance problems they cannot resolve 
should contact Waters Technical Service at 800 252-4752. Others should phone their local 
Waters subsidiary or Waters corporate headquarters in Milford, Massachusetts (U.S.A.).

Table 5-1 lists periodic maintenance schedules you should observe to ensure the 
instrument’s optimal performance.

Note: The maintenance frequencies shown apply to instruments that normally receive 
moderate use.

Table 5-1  Maintenance Schedule

Maintenance Procedure Frequency

Gas-ballast the rotary pump. Daily (APCI)
Weekly (ESI)

Check the rotary pump oil, and top-off when 
necessary.

Weekly

Replace the rotary pump oil. Every 3 months of continuous 
operation, or whenever the oil 
appears markedly discolored

Clean the cone gas nozzle, sample cone, and 
baffle plate.

When sensitivity decreases to 
unacceptable levels

Clean the ESI APCI probe tip, or replace the ESI 
capillary.
Replace the APCI fused silica.

When sensitivity decreases to 
unacceptable levels

Clean the corona discharge needle (APCI mode). When sensitivity decreases to 
unacceptable levels

Clean the ion block assembly. When it is visibly fouled
When background or peak 
contaminants are unaccept- ably 
high

Clean all source components. When sensitivity decreases to 
unacceptable levels
When cleaning the cone gas 
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5.2  Routine Maintenance

Routine maintenance comprises these tasks:

• Checking the rotary pump oil (Section 5.2.1)

• Changing the pump oil (Section 5.2.2)

• Gas-ballasting the rotary pump (Section 5.2.3)

• Replacing the oil mist filter (Section 5.2.4)

• Cleaning the source assembly (Section 5.2.5)

• Cleaning the APCI probe tip (Section 5.2.6)

• Cleaning and replacing the corona discharge needle (Section 5.2.7)

Perform routine maintenance at scheduled intervals (Table 5-1), or when troubleshooting 
indicates it is necessary.

5.2.1  Checking the Rotary Pump Oil

Note: You can check the oil level while the pump is operating.

The rotary pump oil level appears in the rotary pump’s oil level sight glass. Check the oil 
level at weekly intervals. Maintain it at or near the MAX level. If you must add oil, vent and 
shut down the detector before removing the oil filler plug.

Examine the oil each time you check its level. It should be colorless, free of visible 
contaminants. If it is discolored, change it, following the procedure in Section 5.2.2.

5.2.2  Replacing the Pump Oil

Note: You must vent the instrument and shut it down before adding oil.

Change the rotary pump oil after every 3 months of continuous operation, or whenever it 
becomes markedly discolored. Gas-ballast following every oil change.

Required Materials

• Latex or vinyl gloves

• Flat-head screwdriver

• Container to catch used oil
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5• Funnel

• Vacuum oil (use only Ultragrade 19 or Inland Q45 (Edwards 45) vacuum pump oil)

• 4-mm hex wrench
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Procedure

Refer to Figure 5-1 and Figure 5-2 when performing the following procedure.

Note: Operate the pump to warm the oil before you drain it.

Figure 5-1  Rotary Pump Assembly Fitted with Oil Mist Filter

Note: Vent the instrument according to the procedure in Section 5.2.5, and proceed with 
these steps.

1. Turn the instrument’s power switch to Off.

2. Place something under the pump motor, tilting the unit so that the oil drain plug is at 
the lower end.

Caution: Wear latex or vinyl gloves when changing the pump oil.

TP02004

NW25 Inlet 

Gas Ballast Control

Oil Mist Filter

Drain Plug
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Figure 5-2  Rotary Pump Oil Filler Plug, Drain Plug, and Sight Glass

3. Remove the drain plug with the slotted screwdriver.

4. Remove the oil filler plug to facilitate drainage.

5. Drain the oil completely.

6. Flush residual oil from the pump as follows:

a. Refit the oil drain plug.

b. Add about 300 mL of oil to fill the pump to the MIN mark on the sight glass.

c. Refit the oil filler plug.

d. Select Options > Pump from the Tune window (Figure 3-3) to start the pump 
operating. Continue to run the pump for 10 to 15 minutes.

e. Select Options > Vent and click Yes at the prompt to stop the pump.

f. Let the oil drain completely.

7. Use a funnel to add about 1 L of oil to the pump, until the level in the sight glass 
reaches the MAX mark.

8. Allow a few minutes for the oil to fully drain to the bottom of the pump, then recheck 
the level. Add more, if necessary, but do not overfill.

Note: The oil level normally drops about 10% after the pump starts.

9. Refit the oil filler plug.

10. Select Options > Pump from the Tune window (Figure 3-3) to start the pump.

Oil Filler Plug

MAX

MIN

Drain Plug
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5.2.3  Gas-Ballasting the Rotary Pump

The rotary pump draws large quantities of solvent vapors. The vapors tend to condense in 
the pump oil, diminishing pumping efficiency. Gas-ballasting purges condensed 
contaminants from the oil.

Gas-ballast the rotary pump when these conditions apply:

• With ESI operation, once a week

• With frequent APCI operation, once a day

• When the pump oil appears cloudy

• When the vacuum pressure is higher than normal

• When condensate forms in the rotary pump exhaust line

• When you change the rotary pump oil

1. Shut the vacuum system isolation valve, moving its handle fully to the right 
(Figure 5-1).

2. When the oil is clear, return the gas-ballast control to its normal position.

3. Open the vacuum system isolation valve (Figure 5-3).

STOP
Attention: Failure to routinely gas-ballast the rotary pump shortens oil life and, 
consequently, pump life.

STOP
Attention: Do not vent the instrument when the rotary pump is gas-ballasting.

STOP
Attention: Do not gas-ballast the rotary pump while the detector is in operational mode.

STOP
Attention: Never gas-ballast the rotary pump for more than 2 hours.
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Figure 5-3  Isolation Valve

4. Open the gas ballast knob on the top of the pump. Run the pump for 30 to 60 
minutes, then close the gas ballast knob.

5.2.4  Replacing the Oil Mist Filter

Note: Vent the instrument according to the procedure in Section 5.2.5, and proceed with 
these steps.

1. Turn the instrument’s power switch to Off.

2. Unscrew the NW25 clamp, and remove the exhaust line from the top of the oil mist 
filter housing (Figure 5-4).

3. Loosen the four bolts that secure the top and bottom covers of the oil mist housing 
with a 4-mm hex wrench.

Caution: Wear latex or vinyl gloves when replacing the oil mist filter.

Isolation Valve (Open)
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Figure 5-4  Oil Mist Filter Assembly

4. Remove the top cover, and discard the odor filter.

Note: The odor filter will likely stick to the cover.

5. Pull upward on the oil mist filter, removing and discarding it along with its O-ring.

6. Slip the new O-ring over the support post in the bottom of the filter housing, then 
press the new oil mist filter on top.

7. Refit the top cover, securing it with the four screws.

8. Reattach the exhaust hose to the NW25 clamp.

9. Evacuate the system by selecting Options > Pump from the Tune window.

5.2.5  Cleaning the Source Assembly

Clean the sample cone and cone gas nozzle when they are visibly fouled, or when you 
eliminate LC and sample-related causes for decreased signal intensity. When cleaning 
these parts fails to increase signal sensitivity, also clean the extraction lens, hexapole, and 
ion block.

Required Materials

• Lint-free cotton or powder-free nitrile gloves

• 6-in. forceps or needle-nose pliers

• 2.5-mm hex wrench

• 3-mm hex wrench

• 6 mm-hex wrench

Oil Mist Filter Housing

Oil Mist 
Filter Element
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• Small, flat-head screwdriver

• Small, Phillips-head screwdriver

• Clean, 1000-mL beaker

• Clean, 500-mL graduated cylinder 

Note: Use only glassware you have not cleaned with surfactants.

• HPLC-grade methanol

• HPLC-grade water

• Formic acid

• Ultrasonic bath

• Source of oil-free, inert gas (nitrogen or helium) for drying (air-drying optional)

• Lint-free paper towels

Spare Parts

You might need to replace these spare parts when cleaning source components.

Source Cleaning Procedure

1. Disassemble the source components (see “Disassembling Source Components” on 
page 82).

2. Clean the source components (see “Cleaning the Source Components” on page 
88).

3. Remove and clean the hexapole assembly (see “Removing and Cleaning the 
Hexapole Assembly” on page 89).

4. Reassemble the source components (see “Reassembling the Source Components” 
on page 90).

Item Waters Part Number Reference Number

Ion block D-ring (AS035) 700001192 5711312

Viton O-ring (AS214) 700000902 5711294

Extraction cone O-ring 700001897 5711967

Sample cone O-ring 700001194 5711321
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Disassembling Source Components

The source components comprise the pumping block and ion block assemblies, which you 
must disassemble before cleaning. Consult Figure 5-5 and Figure 5-6 when disassembling 
and assembling these assemblies.

1. Stop the liquid flow, then disconnect the LC line from the probe.

STOP
Attention: Never remove either probe before the source heater cools to 
below 100 °C and the source heaters cool to below 50 °C. Doing so will 
shorten the probe heater life. To reduce cooling time, continue flowing API 
gas.

���	���

1 2

3

4
5 6 7

8

10
11

12

1 – Ion Block Assembly
2 – O-Ring, Viton (AS016)
3 – O-Ring, Viton (2-030)
4 – Ion Block Support
5 – O-Ring, Viton (2-039)
6 – O-Ring, Viton (AS016)
7 – O-Ring, Viton 42.0 × 1.5 mm

8 – PTFE Encapsulated O-Ring
9 – Source Pogo Pins

9

10 – PEEK Connector Body
11 – O-Ring, Viton 2-103

 
12 – Threaded Plug

13

13 – Pumping Block
14 – Hexapole

14
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Figure 5-6  Ion Block Assembly

2. Click Press For Standby on the Tune window. The icon changes from green to red. 
This means all high voltages are turned off, as well as the ESI desolvation /APCI 
probe heater.

3. Switch off the source heater by setting a temperature of 20 °C and pressing Enter.

4. Before you remove the ESI or APCI probe, stop the nitrogen flow by toggling  
on the toolbar to Off.

5. Select Options > Vent and Yes, at the prompt. Click OK when the message box 
appears.

���	���

1

1

2

4

4

4

4

4

5
3

7

8

9

10 11 12
13

14

15

16

17

18

19

20

21
22

23

24
25
26

274

4

6

1 – Ion Block Fastener
2 – BS 10 Black Viton O-Ring
3 – Screws, M3 × 20 Cross
4 – M3 × 6 PH
5 – Washer, M3 SS
6 – Cover Plate
7 – Heater Assy
8 – O-Ring, Viton, 2-035
9 – Cone Gas Spring Clip
10 – Terminal Block
11 – Ion Block Plug
12 – Ion Block Plug Seal
13 – Ion Block
14 – Valve Stem

15 – Large Valve Stem Washer
16 – O-Ring, Kalrez, 0.240 × 0.063
17 – Seal Ring
18 – Black Viton O-ring PTFE Encapsulated
19 – Extraction Retainer
20 – Extraction Cone
21 – Sample Cone O-Ring
22 – Sample Cone
23 – Cone Gas Nozzle
24 – O-Ring, Kalrez, AS007
25 – Small Valve Stem Washer
26 – Flat Washer, M4
27 – Metric Hex Nut, M4
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Note: Venting interrupts electrical power to the turbomolecular pump. Nevertheless, 
the pump continues to operate briefly, until rotational speed decreases to less than 
50%, at which point its vent valve opens.

6. Disconnect the appropriate front panel gas and electrical connections.

7. Unscrew the probe’s two knurled thumbscrews, and retract it from the source 
(Figure 5-7)

STOP
Attention: If you are cleaning only the sample and cone gas nozzles, you 
need not vent the system.

Caution: The probe might be too hot to handle. Allow time for it to cool.

STOP
Attention:  Never remove a probe before it cools to below 100 °C and the 
source heater cools to below 50 °C. Doing so shortens the life of the probe 
heater. To reduce cooling time, continue flowing API gas.

Thumbscrew

Clip
Clip

Fastener
Fastener

Source Enclosure CoverSource
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Figure 5-7  Probe Assembly in Position on the Source



8. Remove the center panel (Figure 5-8) from the front of the instrument by grasping its 
sides and pulling it toward you.

Figure 5-8  ZQ Detector Front View

9. Unfasten the two clip fasteners (Figure 5-7) so that the source enclosure opens 
downward on its hinge, allowing access to the source contents.

10. If you are using an APCI probe, carefully remove the corona discharge needle 
(Figure 5-9).

STOP
Attention: Wear lint-free cotton or powder-free nitrile gloves for the rest of 
the cleaning procedure.

Center Panel
Removable
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Figure 5-9  Source Showing the Corona Discharge Needle

11. Remove the PTFE tubing attached to the cone gas nozzle (Figure 5-10).

Corona Discharge
Needle

PTFE Tubing

Ion Block

Corona Pin
Mounting Contact

Pumping Block

Cone Gas

6-mm Hex Screw
Isolation Valve 

PTFE Tubing
6-mm Hex Screw

Spring Clip
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12. Remove the two 2.5-mm hex screws securing the cone gas spring clip 
(Figure 5-10).

13. Remove the cone gas nozzle, O-ring, and sample cone from the ion block.

14. Carefully separate the sample cone from the cone gas nozzle (Figure 5-6). Remove 
the sample cone O-ring (Figure 5-11).

15. Remove the baffle plate, and set all pieces aside.

Figure 5-11  Sample Cone and Cone Gas Nozzle

16. Remove the two 6-mm hex screws that secure the ion block.

17. Remove the ion block from the ion block support (Figure 5-5). The ion block fits 
snugly on the support, so separating them can require considerable effort.

18. Place the ion block on a flat surface, and remove any remaining O-rings that remain 
on it.

19. Use the Phillips-head screwdriver to remove the hold-down screw from the PEEK 

STOP
Attention: Do not scratch the highly polished cone orifice surfaces.

Cone Gas Nozzle

Cone Gas Spring

Sample ConeIon Block

Sample Cone O-Ring

Clip 
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Figure 5-12  Ion Block Rear View

Note: Do not damage the ion block surface and insulator O-ring.

20. Grasp the extraction cone pin with the needle-nose pliers. Lift the extraction cone 
from the ion block.

21. Insert a suitable nonmetallic implement under the inner edge of the polymeric seal 
ring to pry the seal ring and O-ring out of the ion block.

Note: Avoid damaging the seal and O-ring on the ion block.

22. Remove the D-shaped O-ring from the front of the ion block.

Cleaning the Source Components

1. Place the ion block in a beaker with methanol : water (1:1).

2. Place the beaker containing the ion block and methanol/water mixture in an 
ultrasonic bath for 20 minutes.

3. Remove the ion block from the methanol/water mixture, and place it in a beaker 
containing 100% methanol.

4. Place the sample cone, cone gas nozzle, and extraction cone in a beaker containing 
methanol : water (1:1). If debris have accumulated at the sample cone orifice, place 
a drop of formic acid on the orifice before placing it in the beaker.

Note: If the parts are obviously fouled, use a mixture of 45% methanol, 45% water, 
and 10% formic acid.

Hold-Down Screw

Extraction Cone

Extraction 
Retainer (PEEK)
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5. Expose all parts to ultrasound for about 30 minutes. If you used formic acid in the 
cleaning solution, rinse the parts well, immersing them in a beaker of water and 
setting the beaker in an ultrasonic bath for about 20 minutes to remove all traces of 
the acid. Then displace the water by immersing the parts in a beaker of methanol 
and setting the beaker in the ultrasonic bath for 10 minutes.

6. Carefully remove the parts from the beaker. Blow-dry them using inert, oil-free gas. 
Alternatively, arrange the parts on lint-free towels and let them air dry. Wipe off water 
spots with a lint-free cloth.

Removing and Cleaning the Hexapole Assembly

1. Remove the 3-mm screws securing the ion block support, and remove the ion block 
support from the pumping block. Remove any O-rings that remain stuck to the 
pumping block surface (Figure 5-5).

2. Use your hand to gently grasp the hexapole (Figure 5-13), and retract it carefully 
from the analyser assembly.

Figure 5-13  Hexapole Assembly

3. Bend a length of stainless steel tubing into a hook shape. Insert the hook into one of 

Caution: Be extremely careful when working with formic acid. Use a fume 
hood and appropriate protective equipment.

STOP
Attention: Never squeeze the hexapole rods together when you remove the 
hexapole. Their orientation relative to one another is critical to the 
instrument’s performance. Also, avoid scratching the bored surfaces of the 
pumping block as you withdraw the hexapole.

Rear Support Ring

Alignment Notch
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the holes in the assembly’s rear support ring.

4. Carefully suspend the assembly in a graduated cylinder. Add methanol to the vessel 
until it covers the assembly.

5. Place the graduated cylinder in an ultrasonic bath for 30 minutes.



6. Remove the hexapole assembly from the graduated cylinder, and place it on a 
lint-free cloth. Allow it to air-dry, or use a nitrogen flow to dry it.

7. Insert the assembly, aligning the notches in the differential aperture at its rear with 
the two bottom support rails on the analyser assembly. Carefully slide the assembly 
into place (Figure 5-13). Be sure to insert the assembly fully.

8. Check the condition of the three, rear, ion block support O-rings. Replace them with 
new ones, if necessary. Ensure the O-rings are properly installed before reattaching 
the ion block support.

Note: The pilot pin in the ion block support must align with the notch on the ion 
block.

9. Secure the ion block by alternately tightening its retaining screws.

Reassembling the Source Components

1. Visually examine the condition of the three, front, ion block support O-rings 
(Figure 5-5). Replace them, if necessary. Be sure they are properly installed before 
you proceed.

2. Refit the PEEK seal ring and O-ring on the ion block.

3. Press the extraction cone into the ion block support. Secure it with the PEEK 
retainer and screw.

4. Refit the sample cone and its O-ring into the cone gas nozzle. Secure all parts with 
the cone gas spring clip and two 2.5-mm hex screws.

5. Refit the ion block assembly to the PEEK support block. Secure it with two 6-mm 
hex screws. Avoid overtightening.

6. If you have cleaned only the sample and cone gas nozzles, turn the isolation valve 
(Figure 5-10) back to Open.

7. If you are using the APCI probe, replace the corona discharge needle 
(Section 5.2.7).

8. Refit the PTFE tube to the cone gas nozzle.

9. Close the source enclosure, reattaching its clip fasteners.

10. Refit the probe assembly, and reconnect the LC line.

11. Refit the center panel (Figure 5-8) on the front of the instrument.

12. Reconnect the front panel gas and electrical lines.

13. Evacuate the instrument, turn on the API gas, and check for nitrogen leaks around 
Maintaining 90
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5.2.6  Cleaning the APCI Probe Tip

Clean the APCI probe tip when buffer residue accumulates on the probe tip or when signal 
intensity weakens.

1. Stop the liquid flow.

2. Open the source enclosure cover, and close the isolation valve (Figure 5-10). Close 
the source enclosure cover, reattaching its clip fasteners.

3. Click  (API Gas) in the Tune window to start nitrogen flowing.

4. Adjust the nitrogen flow to approximately 650 liters per hour, as indicated by the 
Tune window (Figure 3-3) desolvation gas meter. Set the APCI probe heater 
temperature to 650 °C, and press Enter.

5. Click the Operate icon, and wait 10 minutes with the APCI probe heater at 650 °C. 
This will remove any chemical contamination from the probe tip.

5.2.7  Cleaning and Replacing the Corona Discharge Needle

Clean or replace the needle if it looks corroded or black, and you have noticed decreased 
signal intensity.

Required Materials

• Lint-free cotton or powder-free nitrile gloves

• Lapping film

• HPLC-grade methanol

• Lint-free tissue

Procedure

To clean and replace the corona discharge needle (Figure 5-9):

1. Remove the center panel from the front of the detector (Figure 5-8).

2. Remove the two knurled thumbscrews from the top of the probe.

3. Disconnect the front panel gas and electrical connections (Figure 5-8).

4. Open the source enclosure cover.

STOP
Attention: Wear lint-free cotton or powder-free nitrile gloves for the rest of 
the cleaning procedure.
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5. Remove the corona discharge needle from the source, pulling it straight out.

Caution: The inner surfaces of the source enclosure and its constituent 
components are hot.



6. Clean and sharpen the tip of the needle with the lapping film, then wipe the needle 
clean with a methanol-saturated tissue. Replace the needle if it is deformed or 
otherwise damaged.

7. Reinstall the needle. Point the tip toward the sample cone.

8. Close the source enclosure cover, reattaching its clip fasteners.

9. Reinstall the probe assembly.

5.3  Replacing Parts

5.3.1  Replacing the Ion Block Cartridge Heater

Replace the cartridge heater when it fails to heat.

Required Materials and Spare Part

• 3-mm hex wrench

• 1.5-mm hex wrench

• Slotted screwdriver

• Needle-nose pliers

• Ion block cartridge heater (Figure 5-11), spare part (part number 700001201, 
reference number M955504AD1)
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Procedure

Note: Vent the instrument according to the procedure in Section 5.2.5, and proceed with 
these steps.

1. Remove the cover plate (shown as a cutaway in Figure 5-15) from the ion block.

2. Remove the two screws securing the heater cartridge ring tags from the PEEK 
terminal block (Figure 5-15).

3. Carefully bend the ring tags out of the terminal block.

4. Use the needle-nose pliers to gently retract the heater cartridges from the ion block.

Figure 5-15  Replacing the Heater Cartridge

5. Slide the new heater cartridge into the ion block with the needle-nose pliers.

6. Place the two heater cartridge ring tags onto the PEEK block terminals.

7. Tighten the two terminal block screws with a 20-mm hex wrench.

8. Reinstall the ion block cover plate. Secure it with the four hex screws.

9. Reinstall the source enclosure, probe adjustor assembly, and probe.

5.3.2  Replacing the Stainless Steel Capillary

Replace the stainless steel sample capillary on the ESI probe when it permanently clogs, 
becomes contaminated, or sustains damage.

�������

Ring Tags

Cartridge Heaters
PEEK Terminal Block
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Required Materials

• Flat-head screwdriver

• Needle-nose pliers



• 1.5-mm hex wrench

• 6-mm hex wrench

• 5/16-in. wrench

• 7/16-in. wrench

• Capillary tube (part number 700000341, reference number M955088AD)

• Loupe

Procedure

1. Remove the two end-cover retaining screws on the ESI probe with the slotted 
screwdriver.

2. Loosen the set screw on the LC PEEK union with the 1.5-mm hex wrench, and 
remove the probe’s end-cover.

3. Unscrew the probe tip with the 6-mm wrench, and remove it.

4. Remove the LC union with the 5/16-inch and 7/16-inch wrenches.

5. Unscrew the coupling, and withdraw the capillary from the probe.

6. Remove the capillary and O-ring from the coupling. Discard the capillary, PTFE 
liner, and ferrule assembly.

7. Use the needle-nose pliers to remove the conductive sleeve from the inner bore of 
the probe assembly fitting.

8. Slide a GVF16 ferrule onto the liner tube.

9. Press the O-ring into the groove facing the short end of the coupling.

10. Slide the coupling, short end first, onto the capillary, followed by the new PTFE liner 
tube and ferrule.

11. Slide a compression screw and ferrule onto a piece of 0.007-inch PEEK tubing. 
Connect it to the opposite side of the LC union.

12. Press the capillary into the union until it seats.

13. Tighten the adaptor nut on the LC union so that it is snug but not tight.

14. Gently tug the capillary to make sure it remains secure.

15. Remove the PEEK tubing from the union.

16. Slide the conductive sleeve onto the capillary, then feed the capillary through the 
probe.

17. Attach the coupling nut to the probe, and gently tighten it with the 7/16-inch wrench.
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518. Replace the probe tip, then screw down until a 0.5-mm section of the capillary 
protrudes from its end (Figure 5-16). Use the loupe, provided in the Startup Kit, to 
ascertain its length.
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Figure 5-16  ESI Probe Tip with Capillary Protruding 0.5 mm

19. Replace the probe end cover and secure it with the two slotted screws. Tighten the 
set screw to clamp the LC union in place.

20. Before reinstalling the probe, attach it to the nebulizer gas connection and turn on 
the nitrogen by selecting the API gas icon on the Tune page. 

21. Make sure no nitrogen escapes from the probe tip. If you find a leak, replace the 
probe tip assembly and O-ring.

5.3.3  Replacing the ESI Probe Tip

Replace the probe tip if you encounter any of these problems:

• Gas leaks from the O-ring.

• A blockage in the internal metal sheathing through which the stainless steel capillary 
passes.

• The threads are damaged.

Required Materials and Spare Part

• 6-mm hex wrench

• Loupe

• ESI probe tip, spare part (part number 750000337, reference number M955016BC1)

STOP
Attention: Check carefully for leaks! Leakage can destroy a probe.

������

0.5-mm Protrusion
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Procedure

1. Remove the ESI probe from the source.

2. Unscrew and remove the probe tip with the 6-mm hex wrench.

3. Install the new probe tip, and screw down until 0.5 mm of the capillary protrudes 
from the end. Use the Startup Kit loupe to ascertain the capillary position.

5.3.4  Replacing the APCI Fused Silica Capillary and Filter Pad

Replace the fused silica capillary, and/or filter pad, when signal intensity decreases and 
backpressure increases.

Required Materials

• 1.5-mm hex wrench

• 5/16-in. open-end wrench

• 7/16-in. open-end wrenches (2)

• Ceramic capillary cutter (part number WAT250324 in the Tools Kit)

• Butane lighter or match

• HPLC-grade methanol

• Slotted screwdriver

• Lint-free paper towels

• Loupe

Spare Parts

• Two GVF004 ferrules (part number 700000344, reference number 6070737)

• Fused silica (part number 430000109)

• Filter pad (part number 600000103)

Procedure

1. Slide the probe tip and heater assembly off the probe.

2. Remove the two screws from the probe’s end-cover with the slotted screwdriver.

3. Loosen the two set screws that hold the LC filter, and remove the probe end with the 
hex wrench.

4. Use the two 7/16-inch wrenches to unscrew the filter from the coupling. Then 
remove the ferrule from inside the filter.

5. Use the two 7/16-inch wrenches, to unscrew the two halves of the filter cartridge 
and replace the filter pad. Reconnect the two filter cartridge halves.

6. Remove the old filter pad and replace it with a new one.
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7. Use a 7/16-inch wrench to unscrew the coupling from the probe. Unscrew the 
adaptor nut from the probe with a 5/16-inch wrench.

8. Remove and discard the fused silica capillary, ferrule, and O-ring.

9. Examine the end of a length of new 300 × 100 µm fused silica capillary. Use the 
loupe to ascertain that you cut the end squarely.

Note: Always make perpendicular cuts in the capillary, afterward examining them for 
squareness with the loupe.

10. Feed the fused silica capillary through the probe.

11. Press the new O-ring into the groove facing the short end of the coupling.

12. Slide the coupling (short end first) onto the capillary and finger tighten.

13. Slide a GVF004 ferrule onto the capillary.

14. Position the filter with the flow direction arrow pointing towards the coupling. 
Connect the coupling to the filter, making sure the capillary is fully seated inside the 
filter.

15. Tighten only until the capillary is snug in its fitting, then gently tug it to be sure it 
remains in place. 

16. Tighten the coupling to the probe with a 7/16-inch wrench.

17. Run your fingers across the edges of the ceramic capillary cutter to determine which 
edge is the smooth one. Use the smooth edge to cut the capillary so that 0.5 to 1 
mm extends beyond the nebulizer tip.

Note: The capillary should extend 0.5 to 1.0 mm from the end of the nebulizer. If it 
does not, reinstall the capillary.

18. Unscrew the coupling from the probe and withdraw the capillary from it. 

19. Slide a GVF004 ferrule, followed by the adaptor nut and then another GVF004 
ferrule, onto the capillary.

20. Use a flame to remove about 20 mm of polyamide coating from the end of the 
capillary. Clean with a methanol-saturated tissue.

21. Carefully reinsert the capillary into the probe. Tighten the coupling with a 7/16-inch 
wrench.

22. Replace the probe end-cover and retaining screws.

23. Use the 1.5-mm hex wrench to tighten the set screws in the probe end-cover, 
clamping the filter in place.

24. Replace the probe heater assembly.

STOP
Attention: Overtightening the fitting can damage the capillary.
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5.3.5  Replacing the APCI Probe Heater

Replace the APCI probe heater if it fails to heat.

Required Material and Spare Part

• 0.89-mm hex wrench or slotted screwdriver, depending on the type of screw that 
secures the probe tip

• APCI probe heater, spare part (part number 700000337)

Procedure

1. Loosen the two set screws at the base of the probe tip assembly, and slide the probe 
jacket off the assembly.

2. Separate the heater from the probe body, pulling it parallel to the axis of the probe.

3. Install the new heater onto the probe end-cover.

4. Replace the probe tip assembly, securing it with the two set screws.
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Chapter 6
Troubleshooting

This chapter describes how to troubleshoot the instrument using recommended 
troubleshooting procedures. This chapter addresses the following topics:

• Component hardware troubleshooting

• Checking the APCI probe

6.1  Safety and Handling

Proper Operating Procedures

To maintain optimal performance, follow the operating procedures and guidelines in this 
guide.

Spare Parts

Caution: Observe good laboratory practice when you handle solvents, change tubing, or 
operate the instrument. Refer to Material Safety Data Sheets for the solvents you use, and 
know their chemical properties.

Caution: To avoid possible electric shock, never disconnect an electrical assembly while 
power is applied to the instrument. Once power is turned off, wait about 10 seconds 
before you disconnect an assembly.

Caution: To avoid possible electric shock, do not open the power supply cover. The power 
supply does not contain user-serviceable parts.

STOP
Attention: To prevent circuit damage from static charges, do not touch integrated circuit 
chips or other components that do not require manual adjustment.
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Contacting Waters Technical Service

You can easily correct many problems. Nevertheless, when North American customers 
cannot correct a condition, they should contact Waters Technical Service at 800 
252-4752. All other customers should call their local Waters subsidiary or Waters 
corporate headquarters in Milford, Massachusetts U.S.A.

When you contact Waters, be ready with this information:

• Completed normal operation checklist for the method you are using

• Nature of the symptom

• Waters Micromass ZQ Detector model number and serial number

• Flow rate

• Operating pressure

• Mobile phase(s)

• Detector settings

• Type and serial number of column (if using an HPLC system)

• Sample description

• Control mode (MassLynx, No interaction, other)

• Software version and serial number
Troubleshooting 100
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6.2  Component Hardware Troubleshooting

Table 6-1 contains suggestions for resolving hardware problems.

Table 6-1  Hardware Troubleshooting

Symptom Possible Cause Corrective Action

No ion peaks on the Tune 
window (No Ion Beam)

Operating parameters 
(Capillary/Corona, Cone, 
Extractor, RF Lens, Ion 
Energy, Gas Nitrogen, and 
Heaters) on the Tune 
window are improperly set.

Optimize parameters. See 
Section 3.2.1, Section 3.3.2, 
and Section 3.3.3.

Cables are not properly 
connected.

Ensure all cables are 
correctly attached to the 
source and probe.

Instrument is not in the 
operational mode.

Click Press for Operate 
(Tune window) to put the 
instrument in operational 
mode. The button’s associ-
ated icon turns from red to 
green, and the Operate LED 
on the instrument’s front 
panel reads “On.”

Communication failure. Reinitialize. (Select Options 
> Reinitialize from the Tune 
window.)

No sample is present. Make sure sample is loaded 
in the autosampler or 
syringe.

Isolation valve is closed. Open the isolation valve.

The source components are 
dirty.

Clean the source compo-
nents. See Section 5.2.5.
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No ion peaks on the Tune 
window (No Ion Beam) 
Continued

Insufficient nitrogen flow. Ascertain nitrogen pressure 
is 90 to 100 psi and the gas 
flow rate on the Tune window 
is >100 L/hr. The desolvation 
and probe heaters shut off 
when the nitrogen flow rate 
falls below 100 L/hr.

No LC flow. Check solvent flow from the 
autosampler or syringe 
pump.

A fluid leak developed in the 
HPLC system.

Examine the HPLC system 
for leaks and correct any you 
find.

Broken fused silica capil-
lary in the APCI probe.

Replace the fused silica 
capillary. See Section 5.3.4.

Source components have 
been incorrectly assembled.

Ensure the source and probe 
voltage readbacks vary with 
Tune window settings. If any 
of these voltages are absent, 
disassemble and correctly 
reassemble the source and 
hexapole lens assemblies.

Permanently blocked ESI or 
APCI capillary.

Replace capillary. See 
Section 5.3.4.

Table 6-1  Hardware Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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Unsteady or low intensity 
peaks (Ion Beam)

Poor nebulization due to 
incorrect temperature and 
gas flow settings.

Check temperature and gas 
flow settings. Liquid inside 
the source enclosure is an 
indication that the tempera-
ture is too low. The analyser 
pressure should be less than 
1 x 10–4 mbar. Nitrogen pres-
sure should be from 90 to 
100 psi, and the nitrogen 
flow rate should be greater 
than 100 L/hr. Check the 
stability of the nitrogen flow 
with a good quality, 
two-stage regulator.

Problem with sample 
delivery (autosampler, 
syringe pump).

Troubleshoot the autosam-
pler or check the syringe and 
syringe pump.

Source components are 
dirty.

Clean source components. 
See Section 5.2.5.

Cone voltage ramp is set to 
On.

Set the cone voltage ramp to 
Off.

ESI or APCI capillary is not 
properly installed.

Ensure a capillary height 
setting of 0.5 mm. See 
Section 5.3.4.

Unusually high LC back- 
pressure

Blockage in the capillary 
transfer line or injection loop 
due to particulate matter 
from the sample.

Remove the probe from the 
source, and try to clear the 
blockage by increasing the 
solvent flow rate to 50 
µL/min.

Table 6-1  Hardware Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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Unusually high LC back- 
pressure 
Continued

APCI probe filter pad is 
blocked.

Replace the filter pad. See 
Section 5.3.4.

Tubing from LC system is 
blocked.

Remove the finger-tightened 
nut and tubing from the back 
of the probe. If the back pres-
sure remains relatively high, 
replace the tubing.

The ESI stainless steel 
sample capillary inside the 
probe is blocked.

Try reversing the capillary to 
clear any blockage. If this 
fails to correct the problem, 
replace the capillary.

The ESI capillary is not fully 
seated in the LC union or 
the APCI capillary is not 
properly seated in the filter.

Remove and disassemble 
the probe, and reseat the 
capillary correctly in union.

Unusually low LC back- 
pressure

Leaking connector. Check all fittings and tighten 
where necessary.

Problem with LC solvent 
delivery.

Troubleshoot the LC system.

Broken flow cell in UV 
detector.

Replace the flow cell.

Insufficient vacuum – (any 
reading higher than 1 × 
10–4 mbar on the Pirani 
gauge)

Leaking ion block O-rings. Disassemble the source, and 
examine the ion block 
O-rings. See Section 5.2.5.

Roughing pump not oper-
ating correctly.

Examine the vacuum pump 
oil. If it is dirty, flush the 
pump with clean oil. Then 
refill it with fresh oil. Repeat 
the procedure, if necessary.

Leak in vacuum backing 
line.

Examine the vacuum hose 
for cracks or vacuum leaks.

Restriction in vacuum pump 
exhaust tubing.

Examine the exhaust line for 
restrictions.

Table 6-1  Hardware Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
Troubleshooting 104

The turbomolecular pump 
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Leaking nitrogen (hissing 
sound or solvent smell)

The seal around the source 
enclosure is imperfect.

Examine the source enclo-
sure sealing surfaces for 
imperfections or nicks. Also, 
examine the condition of the 
encapsulated O-rings.

Vacuum oil accumulated in 
the exhaust tubing

Oil mist filter needs 
replacing.

Replace oil mist filter 
element and odor filter. See 
Section 2.3.1.

Vacuum oil accumulating 
inside oil mist housing

Oil return system works only 
when pump is ballasted.

Ballast the pump for 20 to 30 
minutes. See Section 5.2.3.

The Source heaters do not 
operate.

Nitrogen flow is below 
100 L/hr.

Set nitrogen flow to greater 
than 100 L/hr.

A high ambient tempera-
ture or obstructed air flow 
causes overheating.

Lower the ambient tempera-
ture. Ensure sufficient air 
flow around the instrument. 
Remove and clean the fan 
screens.

The APCI heater does not 
operate.

If desolvation heater oper-
ates, the APCI heater might 
need replacing.

Replace the APCI heater.

The instrument vents for 
no apparent reason.

The power supply is being 
interrupted.

Troubleshoot the line power.

Roughing pump fuse fails The oil mist filter element is 
oil-saturated.

Replace the oil mist filter 
element and odor filter. 
Replace the fuse. 

The system needs 
ballasting.

Ballast the pump for 20 to 30 
minutes. See Section 5.2.3.

The line voltage is less than 
208 VAC.

Ascertain that line voltage is 
within specifications.

Vacuum pump oil is dirty. Change vacuum pump oil. 
See Section 5.2.2.

Table 6-1  Hardware Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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Ion Mode drop-down 
menu options are disabled 
or instrument spontane-
ously switches probe type.

One or both of the probe 
contact pins jammed inside 
the probe and do not 
contact the probe support 
plate.

Remove probe cover, free 
the contact pin, and ensure 
that both pins and associ-
ated springs move freely 
within the bushing.

Probe adjustor contact pin 
not making contact.

Remove the probe adjustor 
assembly and check the 
position of the contact pin 
and support plate.

Failure to recognize one 
particular probe type.

Problem with the probe. Remove and try another 
probe of the same type.

Ripple – peaks and base-
line appear to vary 
cyclically in intensity.

Erratic LC solvent flow. Troubleshoot the LC system.

Poor nebulization due to 
incorrect temperature and 
gas flow settings.

Adjust temperature and gas 
flow settings. Liquid on the 
baffle plate indicates the 
temperature is too cold.

Unstable power supplies in 
the source supplies or the 
RF/DC generator or 
unstable photomultiplier 
supply.

Check power supplies and 
RF generator voltages.

Vibration from the rotary 
pumps or even other equip-
ment in the same building.

Check for and eliminate 
excessive benchtop and 
instrument vibration.

Loss of communication 
with instrument

Instrument to MassLynx 
host communication failed.

Reset the workstation and 
restart MassLynx.

IEEE communication 
errors

Instruments powered up in 
the wrong sequence.

Shut off individual system 
components and start the 
system in this order: Work-
station, ZQ Detector, Inlet 
modules. Start MassLynx, 
then wait 3 minutes for the 
audible signal.

Wrong IEEE address or 
conflicting address.

Check system IEEE settings 
and enter the correct 
addresses.

Faulty IEEE cable in IEEE 
chain.

Systematically replace IEEE 
cables until you isolate the 
problematic one.

Table 6-1  Hardware Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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6.3  Inspecting the APCI Probe

1. Switch the instrument to Standby from the Tune window.

2. Make sure the probe heater is off.

3. Unplug the probe from the instrument front panel, and remove it from the source.

4. Connect the PTFE tube to the nebulizer outlet on the front panel.

5. Remove the probe heater assembly, carefully loosening the two set screws.

6. Disconnect the heater from the probe body by pulling it parallel to the axis of the 
probe.

7. Ensure that 0.5 to 1 mm of fused silica protrudes from the stainless steel nebulizer 
tube.

8. Connect the LC pump to the probe with a flow of acetonitrile : water, 1:1, at 
1 mL/min.

9. Make sure the liquid jet flows freely from the end of the capillary and that the LC 
pump pressure reads 250 to 400 psi.

10. Check that the nitrogen supply pressure is 90 to 100 psi (6 to 7 bar).

11. Click  (API Gas) to start the nitrogen flow.

12. Make sure the liquid jet converts to a fine, uniform aerosol.

13. Stop the liquid flow.

14. Click  (API Gas) to stop the nitrogen flow.

15. Reconnect the probe heater assembly.

16. Insert the APCI probe into the source, securing it by tightening the two 
thumbscrews.

17. Connect the probe cable to APCI/ESI on the instrument’s front panel. (Note that you 
must first remove the plug labeled ESI.)
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Appendix A
Using the ESCi Multi-Mode 
Ionization Source

When fitted with the ESCi™ Multi-Mode Ionization Source, the Waters® Micromass® ZQ™ 
Mass Detector alternates between acquiring data in ESI and APCI ionization modes within 
the same run. This software-mediated capability depends on a high voltage power supply, 
which in ESCi mode switches continuously between supplying voltage to the ESI capillary 
and current to the APCI corona needle. Scanning occurs with the ESI probe installed and 
interscan delay times as short as 100 msec. The operating software, MassLynx™ version 
4.0, lets you select ionization modes and polarities in varying combinations and durations.

A.1  Preparing for Operation

Preparing the ZQ Detector for ESCi operation entails these activities:

• Installing the corona discharge needle

• Setting up the MassLynx software

• Performing the Daidzein test

A.1.1  Installing the Corona Discharge Needle

If you have been operating the instrument in ESI mode, you must install the corona 
discharge needle in the instrument’s source. (If you have been operating it in APCI mode, 
the corona needle should be installed already.)

1. Remove the center panel from the front of the instrument, grasping its sides and 
pulling it toward you (Figure A-1).
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Figure A-1  ZQ Mass Detector, Front View

2. Open the source enclosure cover.

3. If the ESI probe is installed, loosen the two knurled thumbscrews that secure it to 
the source. Withdraw the probe several inches, enough to allow your hand easy 
access to the blanking plug.

If the APCI probe is installed, remove it, and replace it with the ESI probe. See the 
Waters ZQ Detector Operator’s Guide for details about installing the ESI probe.

4. Remove the blanking plug from the mounting contact.

5. Install the corona discharge needle on the mounting contact, orienting its tip toward 

Caution: Wear vinyl or latex gloves when working inside the source.

Caution: If you recently operated the instrument, you will find the source 
enclosure’s inner surfaces hot.

Center Panel
Removable
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the sample cone (Figure A-2).

6. Secure the ESI probe, source enclosure, and center panel.
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Figure A-2  Installing the Corona Needle

A.1.2  Setting Up MassLynx

Follow steps 1 through 5 in Section 3.1 to open the MassLynx Tune window (Figure A-3).

Corona Discharge

Mounting Contact

Needle
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Figure A-3  Tune Window
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1. Select Options > ESCi mode (Figure A-4). A check mark appears on the 
drop-down list, beside ESCi, and the Ion Mode column appears in the Peak Editor.

Figure A-4  Tune Window Showing Options List with ESCi Mode Selected

Note: During instrument operation, the Diagnostics page displays voltage-equivalent 
output in current (APCI) mode and current-equivalent output in voltage (ESI) mode 
(Figure A-5). Thus the Current and Voltage values appear to interchange, suggesting that 
current and voltage are simultaneously present. This, however, is not the case. These 
readings reflect only the power supply output, not voltage output at the capillary and 
current output at the corona needle.

Note: A blinking diagnostic indicator light, which in conventional ESI and APCI operation 
denotes an inoperative negative mode, is normal in ESCi operation.

Ion Mode
Column
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Figure A-5  Tune Window, Diagnostics Page

2. Select Ion Mode > ESCi+ or ESCi– to enable the positive or negative ESCi 
ionization mode (Figure A-6).
Using the ESCi Multi-Mode Ionization Source 112

Figure A-6  Selecting the ESCi+ or ESCi- Ionization Mode
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3. Optimize the fast-transitioning values, ES Voltages, APCI Voltages, and Source 
Voltages, for each mode and polarity (Figure A-7).

4. Optimize the slow-transitioning values, Temperatures and Gas Flow, for both ESI 
and APCI performance (Figure A-7).

Note: The ESCi+ and ESCi– pages should display identical slow-transitioning 
values.

5. Select APcI or ESI for each row in the Ion Mode column by clicking the drop-down 
list in each row (Figure A-7).

Note: You cannot select polarity from the Ion Mode column. Instead, click Ion Mode 
in the menu bar, and select mode and polarity from the drop-down list. This 
introduces the ESI+, ESI–, APCI+, or APCI– Source page, which determines an 
acquisition’s polarity.

Figure A-7  Selecting the Ion Mode in the MassLynx Peak Editor

Figure A-8 shows the Tune window as it appears while the instrument operates in ESCi 

Peak 

 
Fast-

Display

 Transitioning
Variables

Slow-
Transitioning

Variables

Ion Mode 
List
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mode.

Note: In the peak display, the APCI peaks appear in blue, the ESI peaks in red 
(Figure A-11).
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Figure A-8  Tune Window as it Appears During ESCi Operation

6. Select MS Method from the Main window shortcut bar (Figure 3-2). The MassLynx 
Function List Editor window appears, its list area blank (Figure A-9). See the 
MassLynx 4.0 Guide to ZQ Data Acquisition for details about this window.

ESI (Red) APCI (Blue)
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Figure A-9  Function List Editor Window (Blank)

7. Click . The Function:n MS Scan dialog box (where n = the function list 
number) appears (Figure A-10).

MS Scan
Button

Function Modes and 
Polarities
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Figure A-10  Function:n MS Scan Dialog Box
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8. Enter parameter values for your sample, then click OK.

Note: Because you must complete this dialog box for each function you specify, 
runs with multiple functions require multiple iterations of this process.

Each time you click OK, the MassLynx Function List Editor window reappears listing 
the scan function you just specified (Figure A-11).

Figure A-11  Function List Editor Window Showing Specified Functions

9. Select Options > ESCi mode to disable ESCi mode and resume normal ESI or 
APCI operation (Figure A-12). The check mark associated with ESCi on the 
drop-down list disappears, as does the Ion Mode column from the Peak Editor.

Note: You can perform ESI-only acquisitions in ESCi mode without compromising 
instrument performance. In doing so, however, be sure to remove the corona 
discharge needle and replace it with the blanking plug.
Using the ESCi Multi-Mode Ionization Source 116
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Figure A-12  ESCi Mode Disabled

A.2  Daidzein Test

Use the Daidzein (Figure A-13) test to prepare the instrument for ESCi operation, evaluate 
its performance, and determine the ratio of peak heights to the level of noise in a mass 
chromatogram (signal-to-noise ratio).

O

O

OH

OH
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Figure A-13  Daidzein (m/z = 255.2 [M + H] and 253.2 [M – H])



A

A.2.1  Test Conditions

A.2.2  Signal-to-Noise Ratio

See the MassLynx User’s Guide for signal-to-noise theory and the Waters Micromass ZQ 
with MassLynx v4.0 Software and Instrument Verification Procedure for details about 
calculating the signal-to-noise ratio as it applies to the ZQ Detector.

Table A-1  HPLC Conditions

Parameter Setting

Column 2.1 × 50 mm, Xterra® C18 (3 µm)

Mobile phase Water: acetonitrile, 70:30

Flow rate 0.5 mL/min

Back pressure ~ 2100 psi

Injection volume 5 µL

Temperature Ambient

Run time 3.0 min.

Table A-2  MS Conditions

Parameter Setting

Ion modes ES+/ ES–/ API–/ API+

Scan range 150 to 500 amu

Scan time 0.2 sec.

Interscan delay 0.1 msec

Photomultiplier tube 450 V

Acquisition time 3.0 min.
Using the ESCi Multi-Mode Ionization Source 118
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Appendix B
Specifications

This appendix describes specifications for the Waters Micromass ZQ Detector and its 
ESCi option.

B.1  ZQ Detector Specifications

Table B-1  ZQ Detector Operational Specifications

Condition Specification

Mass Range:

2000 model 2 to 2000 amu

4000 model 2 to 4000 amu

ESI Sensitivity:

Positive ion Typically, 1 pg (5-µL injection of 0.2 pg/µL) reserpine at 
300 µL/min flow rate = 50:1 S/N-RMS.

APCI Sensitivity:

Positive ion Typically, 1 pg (5-µL injection of 0.2 pg/µL) reserpine at 
1 mL/min flow rate = 50:1 S/N-RMS.

Dynamic range Five orders of magnitude.

Spectral stability Mass accuracy to within 0.2 da over a 24-hour period.

Adduct formation The adduct ion at 273 da will be less than 30% of the molec-
ular ion (232 da) for an infusion of 1 ng fenfluoramine in 
APCI positive mode using 1:1 acetonitrile : water as the 
solvent system.

Resolution The peaks at 1080.8 and 1081.8 from an infusion of PA beta 
cyclodextrin shall be resolved with a valley between them of 
no more than 10% of the average height of the two peaks.
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API Setup Solution

Polypropylene glycol/reserpine/cyclodextrin

Table B-2  ZQ Detector Environmental Specifications

Condition Specification

Operating temperature range 15 to 28 °C (59 to 82.4 °F)

Operating humidity range 20 to 80%, noncondensing

Shipping and storage 
temperature

–20 to 60°C (–4 to 140 °F)

Table B-3  ZQ Detector Dimensions

Condition Specification

Height 23 in. (57.2 cm)

Depth 26 in. (66.1 cm)

Width 15.2 in. (38.1 cm)

Weight (excluding data system 
and rotary pump)

210 lb. (95.3 kg)

Table B-4  ZQ Detector Electrical Specifications

Condition Specification

Line frequency 50 Hz, 47 to 53 Hz 
60 Hz, 57 to 63 Hz

Fuse rating F 2 A, 250 VAC

Analog inputs To 1 VAC

Power consumption 140 VA (Nominal)
Specifications 120
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B.2  ESCi Multi-Mode Ionization Source Specifications  

Table B-5  ESCi Environmental Specifications

Item Specification

Operating temperature range 0 to 45 oC

Altitude Up to 2000 m

Maximum relative humidity 80% for temperatures up to 31 oC, 
decreasing linearly to 50% at 40 oC

Table B-6  ESCi Electrical Specifications

Item Specification

Input voltage +24 VDC ±10%

Current 1.7 A, maximum
Specifications 121
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Appendix C
Accessories and Spare Parts

The tables in this appendix list and indicate the part number for recommended spare parts 
and accessories.

Table C-1  Fuses

Item Part Number

Fuse, 0.5A VFA, SMT little fuse 154.500 700001371

Fuse, 1A, SB, SMT little fuse 154 00IT 700001364

Fuse, 1.5A, SB, SMT little fuse 154 01.5T 700001365

Fuse, 2.5A SB, SMT little fuse 154 02.5T 700001366

Fuse, 2A VFA, SMT R451002 700001370

Fuse, 2A VFA, SMT little fuse 154.002 700001372

Fuse, 3.5A SB, SMT little fuse 154 03.5T 700001367

Fuse, 3A G, FA, 1.25 x 0.25-in. little fuse 312 010 700001362

Fuse, 5A SB, SMT little fuse 154 005T 700001368

Fuse, 8A, Anti-surge Ceramic 1.25 in.x 0.25 in. 700001363

Fuse, A1, FB, SMT little fuse 154, 1F 664-844 700001369

Fuse, Anti-surge 0.375 SMT 154 700001361

ZQ Spare Fuse Kit 700001716

Table C-2  Probe Components

Item Part Number

APCI Probe 700000290

Assy., Heater Shroud, APCI 700000441

Coupling, APCI-ESI, Probe 700000966

ESI Probe 700000289

ESI Probe Assy. 700000289

ESI Probe End Cover 700001667

ESI Probe PEEK Shaft 700002056

Ferrule, 1/16 x 0.3 Bore, GVF 415000110

Ferrule, APCI-GV004, ZQ 700000344
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Ferrule, ESI-GVF16-16 700000343

Heater, APCI Probe 279000112

In-line Filter Anachem A314 600000106

Liner, Ferrule, ESI Probe 430000110

O-Ring, APCI-ESI, Coupling 700000968

Pad, Filter 600000103

Pin, Corona APCI 700000354

Probe adjustor Assy. 700001714

Silica, Fused, APCI Probe 430000109

Sleeve, ESI Conductive 700000969

Tip, Probe Assy. 700000337

Tube, Liner (Normal Flow) 700000640

Tube, PTFE, ESI Probe 430000111

Table C-3  Vacuum Components

Item Part Number

Adaptor NW25, ½ Hose WAT240495

Clamp, Hose 1 in. SS Box 10 WAT241163

Clamp, Hose, 5/8 in. SS Box 10 WAT241162

Controller, Turbo Pump, 24 V 700001127

Edwards 45 Oil, 1 Gallon 700000870

Edwards, ISO 100 Ctr Ring, Viton 700001314

Edwards Oil Return Kit 700000573

Edwards Pump Kit 700001289

Gauge, Pirani, APG L, NW15 700001129

Installation & Oil Filters 700001288

Jubilee Hose Clamp #2

Note: You can use this part instead of part number 
WAT241162.

700000468

LCZ/ZMD Filter, Odor Element 700000871

Ms Oil Mist Filter Housing w/Element WAT241107

Ms VAC Hose PVC 1 in., 25 ft. WAT241165

Ms VAC Hose PVC ½ in., 30 ft. WAT241168

Table C-2  Probe Components (Continued)

Item Part Number
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Ms VAC Hose PVC ¾ in., 20 ft. WAT241397

NW25 Blanking Cap WAT240463

NW25 Center Ring, Viton WAT241160

NW25 Elbow 90 Deg. WAT240443

NW25 Swing Clamp WAT240696

NW25 Tee WAT240462

Oil Mist Filter Element WAT240447

Pump, Split Flow Turbo, Edwards 200/200H 700001128

Tailpiece, NW25-NW25 700001157

VAC NW25 Flange, Lg Butt WAT240828

Table C-4  Valves and Flow Meters

Item Part Number

Kalrez, 0.145 x 0.070 mm 700000903

Kalrez, 0.240 x 0.063 mm 70000902

Tailpiece, NW25-NW25 700001157

Viton, 0.984 x 0.139 700000901

Viton, 12 x 1.5 mm 700001194

Viton, 12 x 1.5 mm 700001167

Viton, 2-010 700000452

Viton, 2-013 WAT241666

Viton, 2-025 WAT241431

Viton, 2-035 700000904

Viton, 2-039 425000112

Viton, 39 x 2.5 mm 700001056

Viton, AS016 700000355

Viton, AS035, PTFE 700001192

Viton, AS039 700001199

Viton, AS214 700001199

Table C-3  Vacuum Components (Continued)

Item Part Number
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Table C-5  Kits

Item Part Number

APCI Probe, Kit Consumable 700000464

APCI Probe, Spare Assy. Kit 700000338

API Calibration Kit 700001593

API Calibration Solution (NACsi) 700001594

API Test Kit 700000889

Basic Spares & Tool Kit 700001287

Edwards Oil Return Kit 700000573

Edwards Pump Kit (contains the oil return connection kit, 
reference number A5042000)

700001289

ESI Probe Assy. Spares Kit 700000336

ESI Probe Installation Kit 700001290

FractionLynx Dye Kit 716000765

Installation & Oil Filters Kit 700001288

Kit, Consumable, ESI Probe 700000463

PM Kit Protocol (ZQ) 715000336

Reserpine Kit 700001673

ZQ PM Kit 201000123

ZQ Source Consumables Kit 700001296

ZQ Source Spares Kit 700001291

Table C-6  Power Supplies

Item Part Number

1000 W DC Power Supply 700001334

DC Power Supply, CA 10000 PSU 700001134

Embedded PC, ZQ 700001606

Generator, RF ZQ 4000 700001300

Generator, RF, ZQ 2000 700001139

GPIB Bd & S/W 186000825

Headamp, Assy., ZQ 700000281

Low Noise Headamp 700001123

Pcb, Ext. Conn., ZQ 700001135

Power Supply, 28,28,24 700001125

Power Supply, 3.3,5,15,15,28 700001126
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Switch, Main 700001146

ZQ A/D Main Sys Board 700001804

ZQ Brandenburg PSU DN 1044 700001140

ZQ Brandenburg PSU DN1043 700001141

ZQ Brandenburg PSU DN1047 Mux Type 700001142

ZQ Single PS Main Wiring 700001360

ZQ Single PS Wiring 700001359

ZQ, I/O Board 700001805

Table C-7  Source and Analyser Components

Item Part Number

Assy., Detector, ZQ 700001161

Block, Sample Cone Locator 700001245

Block, Terminal 700001251

Cone, Gas Nozzle, ZQ 700001236

Cone, Sample, ZQ 700001237

Connector, PEEK, Body Assy. 700001202

Cover Plate 700001234

Extraction Cone, ZQ 700001238

Fastener, ION Block, ZQ 700001241

Heater Assy., ZQ Source 700001201

Hexapole, Assy., ZQ 700001132

ION Block Assy. ZQ 700001198

ION Block, ZQ 700001235

Lens, Phosphor, Platform LC 279000128

Lid, Assy., Quad, ZQ 700001134

Photomultiplier Platform LC 2790000127

Photomultiplier Platform LC 2790000127

Plug M10 7000000906

Plug, Hole, Peek, ION Body ZQ 700001243

Retainer, Extractor, ZQ 700001242

Retainer, Sleeve, Z-couple 700001239

Table C-6  Power Supplies (Continued)

Item Part Number
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Seal Ring, ZQ 700001244

Seal, Plug 700000907

Spring Clip Cone Gas, ZQ 700001232

Stem, Valve 700001240

Support, ION Block ZQ 700001233

ZQ 4000, Lid, Quad Assy. 700001301

ZQ Source Assy. 700001222

ZQ Source Spares Kit 700001291

Table C-8  Washers, Screws, and Nuts

Item Part Number

Hex, Nut, M4, Metric WAT410400

Hex, Nut, M4, Metric WAT410400

LCZ/ZMD/ZA Attach Screw APCI Probe 700000577

LCZ/ZMD/ZQ APCI Knob Grub Screw M3x3 700000579

LCZ/ZMD/ZQ Attach Screw ESI Probe 700000576

LCZ/ZMD/ZQ Attach Screw Knob APCI 700000578

M2x2 APCI Grub Screw Slotted 700000967

Screw Flat HD, M3x6 WAT041240

Screw, M2x6 CH HD, S.S. 700001195

Screw, M2x6 SKT HD CAP 700001168

Screw, M3x20 Cross 410000578

Screw, M4x40 S/H, SST 410000523

Screw, Metric, M3x6 PH WAT411306

Washer Teflon, Ion block fastener 700001929

Washer, Flat, M4 WAT410410

Washer, Large Valve Stem 700001038

Washer, Lock Split M2 WAT410240

Washer, M3 S.S 700001197

Washer, Small, Valve Stem 700001039

Table C-7  Source and Analyser Components

Item Part Number
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Table C-9  Miscellaneous Components

Item Part Number

Basic Spares & Tool Kit 700001287

Cover, LHS, ZQ 700001120

Card, INTEL Pro100 210000169

Cover, RHS, ZQ 700001121

Cover, Top, ZQ 700001119

Guard, Fan 120MM, RS2584639 700001151

Kit, Rebuild, Rheo, RV700-100 700001303

LCZ/ZMD/ZQ Glass Eye Loupe 700000883

Molding, Front, ZQ 700001122

Sample Loop, 10 µL S.S. Rheo, RV700-100 700001302

Stud, Locating Pho/Bronze 700001781

ZQ Instrument Spares Kit 700001118

ZQ Syringe Pump 700001316

ZQ, Power Cord Euro 700001293

ZQ, Power Cord UK 700001292
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Calibration file, setting up  54
Calibration Parameters dialog box  60
Calibration parameters, setting  55
Calibration procedure  63
Calibration report  67

printing  68
updating  68

Capillary
replacing fused silica  96
replacing stainless steel  93

Check calibration acquisition ranges  60
Checking

calibration  67
oil level  33
rotary pump oil  75

Cleaning
APCI probe tip  91
cone gas nozzle  84
corona discharge needle  91
hexapole assembly  89
source  81
source assembly  80

Clearance  31
Components

analyzer  126
miscellaneous  128
probe  122
source  126
vacuum  123

Cone
extraction  88
gas cone  87
retainer  87

Cone gas nozzle, cleaning  84
Connecting

Index
Index 129

saving  71
verifying  71

Calibration Acquisition dialog box  64
Calibration acquisition ranges, check  60
Calibration Acquisition Setup dialog box  64

nitrogen supply and exhaust  35
rheodyne injector  37

Contacting Waters Technical Service  33, 74, 
100
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Conventions, documentation  24
Corona discharge needle

installing  108
removing  108

D
Daidzein test  117

conditions  118
signal-to-noise ratio  118

Damage, reporting  33
Data type  66
Default threshold parameters, adjusting  58
Diagnostics page  112
Dialog boxes

Automatic Calibration  63
Automatic Calibration Check  59
Calibration Acquisition  64
Calibration Acquisition Setup  64
Calibration Parameters  60
Display Calibration Graphs  67
Function: n MS Scan  115
Instrument Threshold Settings  58
Login  41
Mass Measure  62
Open  55
Readback  52
Save As  68
Syringe Selection  45

Dimensions, ZQ Detector  120
Display Calibration Graphs dialog box  67
Documentation

conventions  24
related  23

Drying gas exhaust bottle, installing  36
Duration, run  66
E
Electrical specifications, ESCi  121
Electromagnetic fields  31
Electrospray ionization  28
I

Environmental specifications, ESCi  121
Environmental specifications, ZQ Detector  

120
ES+ Source page parameters  43
ESCi- mode  112
ESCi Multi-Mode Ionization Source  108
ESCi+ mode  112
ESI probe  109

installing  38
replacing tip  95

ESI tuning  44
Exhaust systems, separation of  37

F
Fast scan time  66
Filter, replacing oil mist  79
Flow meters  124
Function List Editor window  116
Function: n MS Scan dialog box  115
Fuses  122

G
Gas-ballasting  76, 78

H
Hardware, troubleshooting  101
Hexapole assembly, removing and cleaning  

89

I
Initial error  61
Injector, connecting  37
Index 130

Inspecting APCI probe  107
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Installing
corona discharge needle  108
drying gas exhaust bottle  36
ESI probe  38
Oil return connection kit  34
rotary pump  33

Instrument Threshold Settings dialog box  58
Intensity threshold  61
Intensity weighting  61
Inter scan delay  66
Ion block  87
Ion block assembly  83
Ion block cartridge heater, replacing  92
Ion mode, selecting in MassLynx Peak Editor  

113
Ionization mode, selecting ESCi+ or ESCi-  

112
Isolation valve  78

K
Kits  125

Startup  32

L
Login dialog box  41

M
Mass analyser  28
Mass Measure dialog box  62
Mass scale, calibrating  54
MassLynx

Diagnostics page  112
Function List Editor window  116

Login dialog box  41
Main window  42
opening  41
security  41
I

Matched peaks, manually editing  71
Maximum standard deviation  60
Miscellaneous components  128
Missed reference peaks  59
Modes

ESCi-  112
ESCi+  112
ion  113
ionization  112

Multi-Mode Ionization Source  108

N
Needle

corona discharge  85
corona discharge, clean and replace  91

Nitrogen stud  36
Nitrogen supply and exhaust, connecting  35
Nuts  127

O
Pump oil  34
Oil level, checking  33
Oil mist filter, replacing  79
Oil return connection kit, installing  34
Open dialog box  55
Opening MassLynx  41
Operating specifications, ZQ Detector  119
Operation, preparing for  108
Overview

ESCi Multi-Mode Ionization Source  108
ZQ Detector  27

P
Parameters
Index 131

acquisition  64
Analyser page  46
APCI+ source  49
calibration  55
ES+ Source page  43
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Parts
fuses  122
power supplies  125
spare  122
Startup Kit  32

Peak window  61
Peaks

matched  71
missed reference  59

Periodic maintenance schedules  74
Pirani gauge  28
Plug, blanking  109
Polynomial order  61
Power requirements  31
Power supply

connecting to  40
parts  125

Preparing
for operation  108
syringe and syringe pump  40

Printing Calibration report  68
Probe adjustor  46, 51
Probes

APCI  109
components  122
ESCi  109

Pump oil, replacing  75
Pumping block assembly  82
Pumps

rotary  33, 75
syringe  40
turbomolecular  27
vacuum  33

R
Readback dialog box  52

Readbacks  52
Reference solution, suggested values  56
Related documentation  23
Relative humidity  31
I

Removing
corona discharge needle  108
hexapole assembly  89
ZQ Detector center panel  108

Replacing
APCI probe heater  98
corona discharge needle  91
ESI probe tip  95
fused silica capillary  96
ion block cartridge heater  92
oil mister filter  79
pump oil  75
stainless steel capillary  93

Rheodyne injector, connecting  37
Rotary pump

adding oil  33
checking oil  75
checking oil level  33
installing  33

Run duration  66

S
Sample cone, cleaning  84
Save As dialog box  68
Saving calibrations  71
Scan from parameter  66
Scan speeds for calibrants other than sodium 

cesium iodide  66
Scan times  66
Scan to parameter  66
Scanning acquisitions  71
Screws  127
Security, MassLynx  41
Selecting

ESCi+ or ESCi-  113
ion mode  113
Index 132

Setting calibration parameters  55
Setting up

calibration file  54
MassLynx  41, 110
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Settings
calibration  55
Tune page  55

Shipping damage, reporting  33
Signal-to-noise ratio  118
Slow scan time  66
Software, MassLynx 4.0  29
Source assembly, cleaning  80
Source cleaning  81
Source components  126
Source parameters, APCI+ Source page  49
Span correction, apply  60
Spare parts  122
Specifications  119

ESCi electrical  121
ESCi environmental  121
ZQ Detector environmental  120
ZQ Detector operating  119

Startup Kit  32
Static dwell  66
Static electricity  31
Static span  66
Syringe pump, preparing  40
Syringe Selection dialog box  45
Syringe stop  40

T
Temperature, operating  31
Test, Daidzein  117
Threshold, intensity  61
Troubleshooting  99

hardware  101
Tune page

Analyzer tab  57
settings  55

Tune window  42, 110

Analyser page  46
APCI+ page  49
Diagnostics page  112
during ESCi operation  114
ES+ Source page  43
I

Tuning in ESI  44
Turbomolecular pump  27

U
Unpacking ZQ Detector  32
Updating Calibration report  68

V
Vacuum components  123
Vacuum pump oil level, checking  33
Vacuum system  27
Valves  124
Venting the source  83
Verifying calibrations  71
Vibration  31
Voltage  31

W
Washers  127
Windows

Function List Editor  115
Main  42
Peak  61
Tune  42, 110

Z
ZQ Detector

dimensions  120
overview  27
removing center panel  85, 90
removing center panel in ESCi 

Multi-Mode Ionization Source  
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108
unpacking  32


